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Installation overview

School or |Task Reference
district
O Ensure your computers and network meet the page 2
SMART Classroom Suite™ interactive learning
software minimum requirements.
O Select a type of installation: page 4
¢ Single classroom
e School or district wide
O Install SMART Sync™ Class List Server. page 17
O Install SMART Administrator Tools - Classlist page 18
Manager.
O Optionally, export information from third-party page 18
applications to CSV files.
O Create a SMART School (.school) file. page 22
O Install teacher components on teacher computers and | page 8
student components on student computers. OR
page 31
Optionally, configure SMART Sync Student software. | page 10

Please send any feedback on this guide to DocumentationFeedback@smarttech.com.
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This guide explains how to customize and deploy the following software as part of
SMART Classroom Suite interactive learning center:

Teacher Student Administrator
o SMART Notebook™ « SMART Notebook SE e« SMART Administrator
collaborative learning (Student Edition) Tools - Classlist Manager
software software « SMART Sync Class List
o SMART Product Drivers ¢ SMART Sync Student Server
o SMART Response™ software

assessment software

e« SMART Sync™ Teacher
software

The suite also includes Gallery content for teacher and student computers.

In addition to the software listed above, you can install SMART Notebook Math Tools software and
try it for free for 30 days .If you have a SMART Document Camera™ 330, you can also install Mixed
Reality Tools for the SMART Document Camera and try it for free for 30 days.

This guide is intended for IT administrators and others experienced with customizing, deploying and
administering Windows® software in a networked environment. To use this guide, you must:
o Know IT terminology such as “registry” and “domain controller”

¢ Know how to complete basic administrative tasks in Windows operating systems such as
modifying the registry
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e Have administrative privileges and access to servers

¢ Have Internet access

IMPORTANT

You must run the commands documented in this guide in an Administrator Command Prompt
window. To open an Administrator Command Prompt window, right-click the Command Prompt
icon, and then select Run as Administrator.

Before you install SMART Classroom Suite software, ensure your computers meet the minimum
requirements defined in this section.

Teacher and system administrator computers
e Windows XP SP3, Windows Vista® SP2 or Windows 7 operating systems

e ForWindows XP SP3 operating systems:
o Pentium® 4 750 MHz or later processor
o 512 MB of RAM (1 GB recommended)
e ForWindows Vista SP2 or Windows 7 operating systems:
o Intel® Core™ Duo 1.5 GHz or later processor
o 1 GB of RAM (2 GB recommended)

e 600 MB of free hard disk space
(1.2 GB for full installation with Gallery content)

¢ 800 x 600 or higher resolution display with 32-bit color quality
¢ Internet Explorer® Internet browser 6.0 or later

e Adobe® Reader® 8 or later

¢ Adobe Flash® Player 10.1 or later

e Windows Media® Player 10 or later for SMART Recorder

¢ DirectX® technology 8.1 or later for SMART Video Player
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Student computers

Windows XP SP3, Windows Vista SP2 or Windows 7 operating systems
For Windows XP SP3 operating systems:

o Pentium 4 750 MHz or later processor

o 512 MB of RAM (1 GB recommended)
For Windows Vista SP2 or Windows 7 operating systems:

o Intel Core Duo 1.5 GHz or later processor

o 1GB of RAM (2 GB recommended)

410 MB of free hard disk space
(1 GB for full installation with Gallery content)

800 x 600 or higher resolution display with 32-bit color quality
Internet Explorer Internet browser 6.0 or later

Adobe Reader 8 or later

Adobe Flash Player 10.1 or later

Windows Media Player 10 or later for SMART Recorder
DirectX technology 8.1 or later for SMART Video Player

Network

802.11 g wireless network (100 Mbps wired network or 802.11 n wireless network
recommended)

SMART Classroom Suite software works with both wired and wireless networks and requires a 10
Mbps TCP/IP network interface adapter.

You can connect up to 30 student computers wirelessly using consumer-grade routers. For better
performance, use a commercial-grade router such as the Cisco® Aironet® wireless access point.
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H nNoTE

Ensure the following network communication ports are open for SMART Sync software:

Port Purpose

5463 (TCP) Main Teacher-to-Student communications port
5485 (TCP) Main Teacher-to-Teacher communications port
5496 (UDP) Teacher discovery port

5491 (UDP) Broadcast port

5493 (UDP) Broadcast recovery port

SMART Classroom Suite software consists of eight components:

Component

Purpose Typical location

SMART Notebook software Enables teachers to create interactive Teacher computers

lesson materials and present them to
students

SMART Product Drivers Enables teacher computers to work Teacher computers

with SMART Board™ interactive
whiteboards or other SMART
interactive products

SMART Response software Enables teachers to gain insightinto ~ Teacher computers

how well students understand lessons

SMART Sync Teacher Enables teachers to connect with Teacher computers
software students and other teachers
SMART Notebook SE Enables students to complete Student computers
software assignments, take notes, manage due

dates and organize digital material
SMART Sync Student Enables students to connect with Student computers
software teachers
SMART Sync Class List Connects teacher and student Server accessible to all
Server computers teacher and student

computers

SMART Administrator Tools Enables teachers and system Teacher or system

- Classlist Manager

administrators to create and edit administrator computers
SMART School files, which are central

repositories of student, teacher, class,

computer lab and computer

information, and application and

Internet blocking rules
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H nNoTE

SMART Sync Class List Server and SMART Administrator Tools - Classlist Manager are optional.
You don’t need to install them to use the teacher and student components. However, there are
benefits to installing them.

Which of these components you install depends on whether you're implementing SMART Classroom
Suite software in a single classroom or across your school or district.

Single classroom installation

A single classroom installation includes all components except SMART Administrator Tools -
Classlist Manager and SMART Sync Class List Server. Teachers and students connect through
SMART Sync software as follows:

e Theteacher creates his or her own teacher ID, classes, application blocking rules and Internet
blocking rules and manages the class with SMART Sync Teacher software.

o Students connect to the teacher through SMART Sync Student software by selecting the
teacher’s ID from a drop-down list or by entering the teacher computer host name or IP
address.

See Installing the software in a single classroom on page 7 for instructions on completing this type of
installation.

H nNoTE

Although this type of installation is preferable if you're installing SMART Classroom Suite software
in a single classroom, complete the procedures for a school- or district-wide installation if you’re
considering installing SMART Classroom Suite software in other classrooms in the future.

School- or district-wide installation
A school- or district-wide installation includes all components of SMART Classroom Suite software.

Teachers and students connect to each other through SMART Sync Class List Server.

Unlike in single classroom installations, in school- or district-wide installations, teacher IDs, classes,
application blocking rules and Internet blocking rules are centrally managed in SMART School files
created with SMART Administrator Tools - Classlist Manager. This makes this type of installation
ideal forimplementing SMART Classroom Suite software across your school or district.

See Installing the software across a school or district on page 15 for instructions on completing this
type of installation.
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classroom

Installing the software. . . .. L 8
Installing SMART Classroom Suite Teacher software. ... . ... ... 8
Installing SMART Classroom Suite Student software. ............................................... 8
Deploying the SMART Classroom Suite software installation packages........................... 9

Connecting students toteachers. ... .. 9

Configuring SMART Sync Student software. ... . .. 10
Running the SMART Sync Student Configuration Tool. ... ... ... . 10
Automatically configuring SMART Sync Student software. ........................................ 13

In a typical single classroom installation, you install SMART Notebook software, SMART Response
software, SMART Sync Teacher software and SMART Product Drivers on one or more teacher
computers and SMART Notebook SE software and SMART Sync Student software on student
computers.

B SMART SMART Board
e Product I - » Interactive

SMART Sync SMART SMART Drivers Whiteboard
Teacher Response Notebook

SMART Sync SMART SMART Sync SMART SMART Sync SMART
Student Notebook SE Student Notebook SE Student Notebook SE

After installation, the teacher creates his or her own class and application and Internet blocking rules
in SMART Sync Teacher software. The students connect to the teacher by selecting the teacher's ID
from a drop-down list or by entering the teacher computer host name or IP address in SMART Sync
Student software. However, you can change the connection option if necessary by configuring
SMART Sync Student software.
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If you're installing SMART Classroom Suite software on a small number of computers or if teachers
and students are responsible for installing software on their own computers, use the installation
wizards to install the software.

You can start the installation wizards by downloading executable (.exe) files from the
SMART Support website.

Installing SMART Classroom Suite Teacher software

To install SMART Classroom Suite Teacher software

1.
2.

Go to smarttech.com/software.

Scroll to SMART Classroom Suite interactive learning software, click Choose a version, and
then select SMART Classroom Suite 2011 software.

Click Downloads, click the Download button in the teacher software section, and then follow
the on-screen instructions to download the SMART Classroom Suite Teacher software
executable file.

Double-click the executable file.

The SMART Classroom Suite Teacher software installation wizard appears.
Follow the on-screen instructions.

Click Install.

Windows Installer installs SMART Classroom Suite Teacher software.

SMART Classroom Suite Teacher software includes SMART Notebook software,
SMART Product Drivers, SMART Response CE software and SMART Sync Teacher
software .

Installing SMART Classroom Suite Student software

To install SMART Classroom Suite Student software

1.
2.

Go to smarttech.com/software.

Scroll to SMART Classroom Suite interactive learning software, click Choose a version, and
then select SMART Classroom Suite 2011 software.


http://www.smarttech.com/software
http://www.smarttech.com/software
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3. Click Downloads, click the Download button in the student software section, and then follow
the on-screen instructions to download the SMART Classroom Suite Student software
executable file.

4. Double-click the executable file.

The SMART Classroom Suite Student software installation wizard appears.
5. Follow the on-screen instructions.
6. Click Install.

Windows Installer installs SMART Classroom Suite Student software.

SMART Classroom Suite Student software includes SMART Notebook SE software and
SMART Sync Student software.

Deploying the SMART Classroom Suite software installation packages
If you're installing SMART Classroom Suite software on a large number of computers, you can
deploy the installation packages to the teacher and student computers as documented in Installing
the software across a school or district on page 15.

After you install SMART Sync Teacher software on the teacher computer and SMART Sync Student
software on student computers, students can connect to the teacher computer through the software.

By default, SMART Sync Student software starts in visible mode when a student first logs on to his
or her computer. The student then enters his or her ID and connects to the teacher computer by doing
one of the following:

o Selecting the teacher’s ID from a drop-down list of teachers currently logged on to
SMART Sync Teacher software if multicasting is enabled on your school’s network

o Entering the host name or IP address of the teacher computer if multicasting isn’t enabled on
your school’s network

B Tip

Teachers can determine the IP address of their computers by selecting Help >
About SMART Sync in SMART Sync Teacher software.

In some classrooms, students always connect to the same teacher or teacher computer. For these
situations, you can configure SMART Sync Student software to connect to a specified teacher ID,
host name or IP address rather than require the students to provide this information each time they log
on.
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For more information, see Configuring SMART Sync Student software below.

Run the SMART Sync Student Configuration Tool to configure SMART Sync Student software on a
student’s computer. The SMART Sync Student Configuration Tool updates the local machine registry
on the student’s computer.

Running the SMART Sync Student Configuration Tool

If you want to configure a SMART Sync Student software installation, run the SMART Sync Student
Configuration Tool.

To run the SMART Sync Student Configuration Tool

1. Select Start > All Programs > SMART Technologies > SMART Tools > SMART Sync
Student Configuration Tool 2011.

The SMART Sync Student Configuration Tool appears.
2. Click Next.

3. Inthe Interface page, select one of the following options, and then click Next.

Option Select this option to:

Visible to students Show the SMART Sync Student software user interface to the
student.

Hidden from students Hide the SMART Sync Student software user interface from the
student.

H NoTE

If you select Hidden from students, the student won’t be able to do the following:
o Connect to a teacher by selecting the teacher's name from a list
o Manually start SMART Sync Student software
o Manually enter an ID after starting SMART Sync Student software

The relevant controls in the SMART Sync Student Configuration Tool will be disabled or
hidden.

10
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4. Inthe Startup page, select one of the following options:

Option Select this option to:
Allows the student to Allow the student to select a teacher from a drop-down list using
select from a list of teacher discovery.

available teachers
H NoTE

This option is disabled if you clicked Hidden from students
in step 3.

Automatically connects  Connect SMART Sync Student software to a specific teacher
with this Teacher ID through the teacher’s ID.

Type the ID in the box below the option.

Automatically connects  Connect SMART Sync Student software to a specific teacher
with this hostname or IP  computer through the host name or IP address.

address Type the host name or IP address in the box below the option.

H NoTE

If your network uses DHCP, refer to the computer by host
name rather than by IP address.

Automatically connects  Connect SMART Sync Student software to a specific teacher
specified in a SMART Schooal file.

5. If you selected Allows the student to select from a list of available teachers and want to
use SMART Sync Class List Server for teacher discovery, or if you selected Automatically
connects, select the Uses this Class List Server host name or IP address check box.

Type the host name or IP address of the SMART Sync Class List Server computer in the box
below the check box.

H NoTE

If your network uses DHCP, refer to the SMART Sync Class List Server computer by host
name rather than by IP address.

6. If the computer has multiple network adapters, click Network Adapter Selection to specify
the order of the network adapters.

7. Click Next.

8. Inthe Options page, clear the Start SMART Sync Student automatically check box if you
don’t want SMART Sync Student software to start when the student first logs on.

H NoTE

This check box is disabled if you selected Hidden from students in step 3.

11
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9. Select the check boxes for the options you want to enable, and then click Next.

Check box

Select this check box to:

Ask questions

Allow the student to ask questions through
SMART Sync software.

Chat Allow the student to chat with other students through
SMART Sync software.
Submit files Allow the student to submit files through SMART Sync

software.

Exit the Student program Allow the student to close SMART Sync Student software.

H NoTE

These check boxes aren't visible if you clicked Hidden from students in step 3.

10. Inthe Student ID page, select one of the following options, and then click Next.

11.

12

Option

Select this option to:

Student Controlled

Allow the student to enter an ID when SMART Sync Student
software starts.

H noTE

This option is disabled if you selected Hidden from students
in step 3.

The following

Enter a specific student ID.
Type the ID in the box to the right of the option.

Found in this
Active Directory field...

Find the student ID in an Active Directory® directory service
field of the student’s login account.

Type the field name in the box to the right of the option.

Anonymous

Allow the student to use SMART Sync Student software
without entering an ID.

In the Shared Files Folder page, select one of the following options, and then click Next.

Option

Select this option to:

My Documents folder

Store files the teacher shares with the student in the

My Documents folder (Windows XP and Windows 7 operating
systems) or the Documents folder (Windows Vista operating
system).

Custom folder

Store files in another folder.
Type the path to the folder in the box below the option.
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12. Inthe Security page, select one of the following options, and then click Next.

Option Select this option to:

No security Allow any teacher with SMART Sync Teacher software to
connect to the student.

Allow only teachers with  Allow only teachers who enter a specified password in
this class password SMART Sync Teacher software to connect to the student.

Type the password in the two boxes to the right of the option.

Allow only Teachers who Allow only teachers in certain groups to connect to the student.
are part of the following  Select the groups in the box below the option.
group(s)

13. Click Finish.
The Restart Required to Apply Settings message appears.
14. Click OK.

Automatically configuring SMART Sync Student software

CAUTION

Use caution when you open the Windows registry editor. If you incorrectly modify the Windows
registry, you can damage your computer’s operating system. Back up your registry before
performing the following procedures.

13
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After you configure SMART Sync Student software on one student computer you can apply the same
configuration to other student computers by exporting the SMART Sync Student registry key
(located in HKEY_LOCAL_MACHINE\SOFTWARE\SMART Technologies) to afile, and then
importing the file on the other student computers.

The SMART Sync Student Configuration Tool modifies the following registry values in the SMART
Sync Student registry key:

14

Visible

AutoStart
ConnectTeacherlD
ConnectIP
StoreFilesToMyDocs
CustomSharedFolder
RedrawHooks
MirrorDriver
UnicastNoDelay
MulticastTTL
EnableChat
EnableQuestions
EnableFileTransfer

EnableHelp

DisplayExit
BroadcastZoomWindow
CtrlAltDelSettings
NICListLength
PasswordHash
NamingServerlLoc
NamingServerPassedTest
SecurityUsed
ConnectionUsed
StudentIDMode
StudentID
ActiveDirStudentldField
EnableNICDefaultOrder
NTGroupListLength
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In a typical school- or district-wide installation, you deploy SMART Notebook software,

SMART Response software, SMART Sync Teacher software and SMART Product Drivers to all
teacher computers and SMART Notebook SE software and SMART Sync Student software to all
student computers. As a system administrator, you install SMART Sync Class List Server to
connect teacher and student computers and create a SMART School file with SMART Administrator
Tools - Classlist Manager to centralize teacher, student and class information as well as application
and Internet blocking rules.
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0 x

—»| Administrator
Tool

= . Teacher .‘ SMART Product
| = -
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‘ e gl
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|
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|
|
|
| t
|
|
|
|
|
|

SMART Sync SMART SMART Sync SMART SMART Sync SMART
Student Notebook SE Student Notebook SE Student Notebook SE
A A
s e

IMPORTANT

SMART Administrator Tools - Classlist Manager is beneficial for centrally managing teacher,
student and class information across a school or district.

Install SMART Sync Class List Server and SMART Administrator Tools - Classlist Manager and
create a SMART School file before you install SMART Sync Teacher software and SMART Sync
Student software. This enables you to connect SMART Sync Teacher software to the

SMART School file and SMART Sync Student software to SMART Sync Class List Server during
installation rather than having to do so manually after installation.

16
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In a typical school- or district-wide installation, you install SMART Sync Class List Server on a server
or other computer on your school’s or district’s network that all teacher and student computers can
access.

To install SMART Sync Class List Server

1. Go to smarttech.com/administratordownloads.

2. Scroll to SMART Sync classroom management software, click Choose a version, and then
select SMART Sync 2011 Software for Windows.

3. Follow the on-screen instructions to download the SMART Sync Administrator Tools
executable file.

4. Double-click the executable file, and then follow the on-screen instructions.

5. Inthe component installation step of the wizard, select the SMART Sync Class List Server
check box and clear the other check box.

6. Click Install.

Windows Installer installs SMART Sync Class List Server.

SMART Administrator Tools - Classlist Manager allows you to create SMART School files.

A SMART Schooal file contains information about students, teachers, classes and computer labs in
your school as well as rules that teachers can apply to block student access to applications and
websites. If you specify the location of a SMART School file in SMART Sync Teacher software,
teachers can use this information to populate their classes.

In most situations, you only need to create one SMART School file per school so that all teachers and
students in the school can connect to each other. For security reasons, when you create the file, save
it in a location accessible to teachers and system administrators, but not to students. After creating
the file, you can update it.

17
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NOTE

Although a teacher can use Teacher Tools to make changes to the class list, the changes are
written over when the system administrator updates the .school file.

Installing SMART Administrator Tools - Classlist Manager
In a typical school- or district-wide installation, you install SMART Administrator Tools - Classlist
Manager on one or more system administrator computers.

To install SMART Administrator Tools - Classlist Manager

1.
2.

Go to smarttech.com/administratordownloads.

Scroll to SMART Sync classroom management software, click Choose a version, and then
select SMART Sync 2011 Software for Windows.

Follow the on-screen instructions to download the SMART Sync Administrator Tools
executable file.

Double-click the executable file, and then follow the on-screen instructions.

In the component installation step of the wizard, select the SMART Administrator Tool
check box and clear the other check box.

Click Install.

Windows Installer installs SMART Administrator Tools - Classlist Manager.

Using information from third-party applications
If you manage school information using a third-party application, you might be able to export the
school information to a comma separated values (CSV) file to use it in your SMART School file.

The information that the CSV file contains depends on how computers are used in your school.

Creating a CSV file for schools with individual computers
If each student has his or her own laptop or assigned computer in a class, create a CSV file that
contains student, teacher and class information.

PersonID, LastName,FirstName,Title,ClassID,ClassTitle, Type
5001, Adams, John, ,Eng,English, 0
s5002,Brook, Sally, ,Eng,English,0

5003,Williams,Ronald, ,Eng,English, 0O

T001l, Johnson, Adam,Mr.,Eng,English,1

18
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IMPORTANT

If a teacher or student is in multiple classes, the CSV file must contain multiple lines for that
teacher or student (one for each class).

To create a student, teacher and class CSV file

1. Export student, teacher and class information from the third-party application to a CSV file.

B NOTE
See the third-party application’s Help for instructions.

2. Open the CSV file using Microsoft® Excel® or another application that can open CSYV files.

19
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3. Ensure the CSV file contains the following columns:

Column name

Type

Description

PersonlD

String

The student’s or teacher’s unique ID.
IMPORTANT

o The ID you enter here must match the ID the
student uses to log on to SMART Sync Student
software.

o The ID must be unique to the student or teacher.
For example, a student and a teacher can’t both
have the ID 123456.

LastName

String

The student’s or teacher’s last name.

FirstName

String

The student’s or teacher's first name.

Title

String

The teacher’s title (for example, Mr., Ms. or Dr.).
B NoTE

SMART Administrator Tools - Classlist Manager only
stores this information for teachers.

ClassID

String

The unique ID of the student’s or teacher’s class.

ClassTitle

String

The name of the student’s or teacher’s class.

If appropriate, include the class’s period to distinguish it
from other classes.

Type

Integer

0 for a student.
OR
1 for a teacher.

H NOoTEs

o The first row of the spreadsheet must contain the column names as listed in the table

above.

o The string columns can contain any character except a comma ().

4. Savethe CSV file.

20
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Creating a CSV file for schools with computer labs
If your school’s computers are located in labs, create a CSV file that contains computer lab
information.

Hostname,WorkstationName, LabID, LabTitle
127.0.0.1,Main Lab WS1l,Main,Main Lab

127.0.0.2,Main Lab WS2,Main,Main Lab
127.0.0.3,Main Lab WS3,Main,Main Lab
127.0.0.4,Main Lab WS4,Main,Main Lab
127.0.0.5,Main Lab WS5,Main,Main Lab

To create a computer lab CSV file

1. Export computer lab information from the third-party application to a CSV file.
EH NoOTE
See the third-party application’s Help for instructions.

2. Openthe CSV file using Excel or another application that can open CSV files.

3. Ensure the CSYV file contains the following columns:

Column name Type Description
Hostname String The computer’s host name or IP address (for example,
127.0.0.1).
B NoTE

If your network uses DHCP, refer to the computer by
host name rather than by IP address.

WorkstationName  String The computer’s name.

LabID String The unique ID of the computer’s lab.
LabTitle String The name of the computer’s lab.

H NoTEs

o The first row of the spreadsheet must contain the column names as listed in the table
above.

o The string columns can contain any character except a comma (,).

4. Savethe CSV file.
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Creating a SMART School file
After you install SMART Administrator Tools - Classlist Manager and export information from third-
party applications to CSV files, you can create a SMART School file.

IMPORTANT

If you are upgrading to SMART Classroom Suite 2011 software from SMART Classroom Suite
2009 or 2010 software, do the following:

o Create anew SMART School file following the instructions in Creating a SMART School file
above.

o Delete the teacher files of administered teachers.

In Windows XP operating system, these files are in C:\\Documents and Settings\
All Users\Documents\SMART Technologies\SMART Sync

In Windows Vista and Windows 7 operating systems, these files are in
C:\Users\Public\Documents\SMART Technologies\SMART Sync
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The specific steps you complete to create a SMART School file depend on how you want to include

school information in the file.

If you want to:

Complete these steps:

Create CSV files and import their
contents into a SMART School file
using the command line tool.

1.

Import the contents of the CSV file using the
command line tool (see page 25).

Open the SMART School file in SMART
Administrator Tools - Classlist Manager (see page
23).

Create administered application and Internet
blocking rules (see page 29 and page 30).

Review the SMART School file (see page 31).

Create CSV files and import their
contents into a SMART School file
using SMART Administrator Tools -
Classlist Manager.

Start SMART Administrator Tools - Classlist
Manager and create a new SMART School file (see
page 23).

Import the contents of the CSV file using SMART
Administrator Tools - Classlist Manager (see page
24).

Create administered application and Internet
blocking rules (see page 29 and page 30).

Review the SMART School file (see page 31).

Enter school information directly in
SMART Administrator Tools -
Classlist Manager.

Start SMART Administrator Tools - Classlist
Manager and create a new SMART School file (see
page 23).

Enter school information in SMART Administrator
Tools - Classlist Manager (see page 26, page 27 and
page 27).

Create administered application and Internet
blocking rules (see page 29 and page 30).

Review the SMART School file (see page 31).

Starting SMART Administrator Tools - Classlist Manager
The first step in using SMART Administrator Tools - Classlist Manager is to create or open a

SMART School file.

To create a SMART School file

1. Double-click the SMART Administrator Tools - Classlist Manager 2011 icon on your

desktop.

The SMART Administrator Tools - Classlist Manager window appears.
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Click School File, click Create a new SMART School file and save it as, and then click
Browse.

The Select School File Location dialog box appears.

Browse to the folder where you want to create the SMART School file.

IMPORTANT

For security reasons, create the SMART School file in a location that is accessible to
teachers and system administrators but not to students. Teachers can have read-only
access to the file, but system administrators require read/write access.

Type a name in the File name box.
Click Save.

The Select School File Location dialog box closes, and the path to the SMART School file
appears in the box below the Create a new SMART School file and save it as option.

To open a SMART School file

1.

Double-click the SMART Administrator Tools - Classlist Manager 2011 icon on your
desktop.

The SMART Administrator Tools - Classlist Manager window appears.

Click School File, click Edit the existing SMART School file in this location, and then
click Browse.

The Open School File dialog box appears.
Browse to and select the SMART Schooal file.
Click Open.

The Open School File dialog box closes, and the path to the SMART School file appears in the

box below the Edit the existing SMART School file in this location option.

Importing school information using SMART Administrator Tools - Classlist Manager

You can manually enter student, teacher and class or computer lab information in SMART School
files using SMART Administrator Tools - Classlist Manager. Alternatively, you can generate CSV
files from a third-party application (see Using information from third-party applications on page 18)
and then import the contents of these files into the SMART School file using SMART Administrator

Tools - Classlist Manager as described in this section or using the command line tool as described in

the next section (see page 25).
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To import student, teacher and class information

1.

Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

Click Import Information.

Click Browse to the right of the Student, Teacher, Class CSV file Location box.
The Open Classes CSV File dialog box appears.

Navigate to and select a student, teacher and class CSV file.

Click Open.

The Open Classes CSV File dialog box closes, and the path to the CSV file appears in the
Student, Teacher, Class CSV file Location box.

To import computer lab information

1.

Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

Click Import Information.

Click Browse to the right of the Computer, Lab CSV File Location box.
The Open Labs CSV File dialog box appears.

Navigate to and select a computerlab CSV file.

Click Open.

The Open Labs CSV File dialog box closes, and the path to the CSV file appears in the
Computer, Lab CSV File Location box.

Importing school information using the command line tool
You can import the contents of CSV files using the command line tool rather than SMART
Administrator Tools - Classlist Manager.

To import school information

1.
2.
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Open a command prompt window.
Open the following folder in the command prompt window:

[Program filesA\SMART Technologies\SMART Administrator Tools 2011\
CSVtoSchool.exe



CHAPTER 3

Installing the software across a school or district

3. Type the following command, and then press ENTER:

CSVtoSchool /classcsv: [Class CSV file path]
/labcsv: [Computer lab CSV file path]
/schoolfile: [SMART School file path]

Where

o [Class lab CSV file path] is the path and file name of the student, teacher and class CSV
file

o [Computerlab CSV file path] is the path and file name of the computer lab CSV file
o [SMART School file path] is the path and file name of the SMART School file.

I NOTES

o Ifthe SMART School file doesn’t exist, the tool creates the SMART School file and
includes the student, teacher and class or computer lab information from the CSV file
init.

o |Ifthe SMART School file exists, the tool replaces the student, teacher and class or
computer lab information with the contents of the CSV file, but the Internet blocking
rules and application blocking rules remain the same.The database ID of the
SMART School file remains the same.

o If there are errors, a message appears, displaying an error number that indicates the
problem.

o |f there are no errors, a 0 error message appears.
Entering student information
You can import student information from a CSV file (see Importing school information using SMART

Administrator Tools - Classlist Manager on page 24). Alternatively, you can manually enter student
information in a SMART School file using SMART Administrator Tools - Classlist Manager.

B NoTE

Student information is required only if you’re entering classes in the SMART School file (see
Entering class or computer lab information on the next page).

To add a student

1. Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

2. Click Students, and then click Add Student.

A new row appears in the table.
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3. Type the student’s last name in the Last Name column.
4. Type the student’s first name in the First Name column.

5. Type the student’s ID in the Student ID column.

IMPORTANT

The ID you enter here must match the ID the student uses to log on to SMART Sync Student
software.

H NoTE

SMART Administrator Tools - Classlist Manager generates a random ID for the student if you
don’t specify one.

Entering teacher information
You can import teacher information from a CSV file (see Importing school information using SMART

Administrator Tools - Classlist Manager on page 24). Alternatively, you can manually enter teacher
information in a SMART School file using SMART Administrator Tools - Classlist Manager.

H nNoTE

Teacher information is required only if you're entering classes in the SMART Schooal file (see
Entering class or computer lab information below).

To add a teacher

1. Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

2. Click Teachers, and then click Add Teacher.
A new row appears in the table.
3. Type the teacher's last name in the Last Name column.
4. Type the teacher’s first name in the First Name column.
5. Type the teacher's title in the Title column (for example, Mr., Ms. or Dr.).

Entering class or computer lab information
If each student has his or her own laptop or assigned computer in a class, you must enter classes in

the SMART School file.
OR

If computers are located in labs in your school, you must enter the labs in the SMART School file.

27



CHAPTER 3

Installing the software across a school or district

You can import class or computer lab information from a CSV file (see Importing school information
using SMART Administrator Tools - Classlist Manager on page 24). Alternatively, you can manually
enter class or computer lab information in a SMART School file using the Classes section or
Computer Labs section of SMART Administrator Tools - Classlist Manager.

To add a class

1.

5.

Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

Click Classes, and then click Add.

A new row appears in the table.

Type a name in the Class Name column (for example, 5th Grade Math).

If appropriate, include the class’s period to distinguish it from other classes.
Select the name of a teacher or student you want to include in the class in the

All Students and Teachers list, and then click E] to move it to the Class Members list.

H NoOTES

o Inthe All Students and Teachers and Class Members lists, teachers’ names appear in
red text and students’ names appear in black text.

o Toremove teachers or students from a class, select their names in the Class
Members list, and then click E] to move them to the All Students and Teachers list.

Repeat step 4 for each teacher or student that you want to add to the class.

To add a computer lab

1.
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Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

Click Computer Labs, and then click Add.

A new row appears in the computer lab table.

Type a name in the Lab Name column (for example, Main Lab).
Click Add Computer.

A new row appears in the computer table.
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5. Type the host name or IP address of the computer in the Hostname column (for example,
127.0.0.1).
H NoTE
If your network uses DHCP, refer to the computer by host name rather than by IP address.

6. Type the name of the computer in the Workstation Name column (for example,
Main Lab WS1).

7. Repeat steps 4 to 6 for each computer you want to add to the computer lab.

H nNoTE

To remove a computer from the computer lab, select the computer, and then click
Remove Computer.

Creating administered application blocking rules

An application blocking rule enables teachers either to allow specific applications and block all others
or to block specific applications and allow all others. For example, an English teacher could allow
access to Microsoft Word but block access to all other applications while students are writing an
English paper.

Teachers can individually create and share application blocking rules in SMART Sync Teacher
software. Alternatively, you can create centrally administered application blocking rules and include
them in a SMART School file.

To create a rule

1. Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

2. Click Application Blocking, and then click Add.
A new row appears in the application blocking rule table.
3. Type a name in the Rule Name column (for example, English Paper).

4. Select Block all applications except those listed below to block access to all applications
except those you include in the rule.

OR

Select Allow all applications except those listed below to allow access to all applications
except those you include in the rule.

5. Click Add Application.

A new row appears in the application table.
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6.

Type a name for the application in the Display Name column if you don’t want to use the
default name.

Type the path to the application in the Application Path column.
Select Windows or Mac in the Operating System column.

Repeat steps 5 to 8 for each application you want to add to the application blocking rule.

H nNoTE

To remove an application from the application blocking rule, select the application, and then
click Remove Application.

Creating administered Internet blocking rules

An Internet blocking rule enables teachers either to allow specific websites and block all others or to
block specific websites and allow all others. For example, a history teacher could block access to
online encyclopedias and other history resources while students are writing a history paper.

Teachers can individually create and share Internet blocking rules in SMART Sync Teacher software.
Alternatively, you can create centrally administered Internet blocking rules and include them in a
SMART School file.

To create a rule

1.
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Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

Click Internet Blocking, and then click Add.
A new row appears in the Internet blocking rule table.
Type a name in the Rule Name column (for example, History Paper).

Select Block all websites except those listed below to block access to all websites except
those you include in the rule.

OR

Select Allow all websites except those listed below to allow access to all websites except
those you include in the rule.

Click Add Website.
A new row appears in the website table.

Type the address of the website in the Website Address column.
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7. Repeat steps 5 and 6 for each website you want to add to the Internet blocking rule.

H nNoTE

To remove a website from the Intemnet blocking rule, select the website, and then click
Remove Website.

Reviewing the SMART School file

After creating a SMART School file, you can review it in the Summary section and then close
SMART Administrator Tools - Classlist Manager to save the file. You should complete the following
tasks before you review and save the file:

¢ Import school information (see Importing school information using SMART Administrator Tools

- Classlist Manager on page 24 or Importing school information using the command line tool on
page 25).

OR

Enter student, teacher or class information (see Entering student information on page 26,
Entering teacher information on page 27, and Entering class or computer lab information on
page 27).

OR
Enter computer lab information (see Entering class or computer lab information on page 27).

Create administered application blocking rules (see Creating administered application blocking
rules on page 29).

Create administered Internet blocking rules (see Creating administered Intemet blocking rules
on the previous page).

To review the SMART School file

1.

Start SMART Administrator Tools - Classlist Manager (see Starting SMART Administrator
Tools - Classlist Manager on page 23).

Click Summary.
If any warnings appear, read them and take the appropriate actions.

Click Exit.

After you install SMART Sync Class List Server and SMART Administrator Tools - Classlist
Manager and create a SMART School file, you can install SMART Notebook software,
SMART Product Drivers, SMART Response software and SMART Sync Teacher software on
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teacher computers and SMART Notebook SE software and SMART Sync Student software on
student computers.
Installing teacher and student software across a school or district involves three steps:

1. Locating the installation files

2. Customizing the installation packages

3. Deploying the installation packages

Installation packages and supporting files
Before you can customize or deploy SMART software, you must locate the installation packages and
supporting files.

Installation packages
There are five installation packages (also known as MSI files) for SMART Classroom Suite software:

Installation package File name Components
SMART Classroom SMART Education o SMART Notebook software
Suite Teacher software Software 2011.msi . SMART Product Drivers

o SMART Response software
e« SMART Sync Teacher software

SMART Classroom SMART Classroom o SMART Notebook SE software
Suite Student software Suite Student.msi « SMART Sync Student software
SMART Administrator SMART o SMART Administrator Tools - Classlist
Tools Administrator Tools Manager

2011.msi o SMART Sync Class List Server
Adobe Flash Player install_flash_player_ o Adobe Flash Player ActiveX control
ActiveX® control 10_active_x.msi (for SMART Notebook software)
Adobe Flash Player install_flash_player_ « Adobe Flash Player plug-in
plug-in 10_plugin.msi (for SMART Response software)

Download these installation packages from smarttech.com/administratordownloads.

Save the packages in a location on your network that’s accessible to all computers on which you plan
toinstall the software.

Language files

If you plan to deploy the installation packages in a language other than English (U.S.), ensure the
corresponding MST file for the language is in the same folder as the MSI file (see Installation
language files and codes on page 101).
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Similarly, if you want teachers to be able to view and use SMART Notebook software in a language
other than English, you must download and install the appropriate language pack (see Language
packs on page 103). If you want to support handwriting recognition in SMART Notebook SE software
in a language other than English, you must download and install the MSI file for the language (see
Handwriting recognition language files and codes on page 102).

Customizing the installation packages
Before you deploy installation packages, you can customize them for your environment by creating
MST files.

IMPORTANT

If you installed SMART Sync Class List Server and SMART Administrator Tools - Classlist
Manager and created a SMART School file, customize the SMART Classroom Suite Teacher
software installation package to reference the SMART School file location and the SMART
Classroom Suite Student software installation package to reference the SMART Sync Class List
Server location.

You can create MST files using SMART Install Manager (see page 41).

OR

You can create MST files using a third-party tool such as Orca database editor and the Windows
Installer properties (see page 59).

Deploying the software
You can deploy installation packages using the command line interface.

OR

You can deploy installation packages using third-party imaging or remote management software.

H NoTE
You might need to manually activate the software after you deploy it.
Using the command line interface

Using the command line interface, you can deploy installation packages in many ways, including
running commands from the Command Prompt window and including commands in batch script files.

IMPORTANT

Before you deploy the SMART Sync Teacher software installation package, you must install
Windows Installer 4.5 (see support.microsoft.com/kb/942288).
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Toinstall SMART Classroom Suite Teacher software, you must deploy the SMART Education
Software 2011.msi, install_flash_player_10_active_x.msi and install_flash_player_10_
plugin.msi files.

To install SMART Classroom Suite Teacher software

Run the following command if you created an MST file to customize the installation package:

msiexec /i " [Path]\SMART Education Software 2011.msi" TRANSFORMS="[MST

file]" [Parameter]

OR

Run the following command if you didn’t create an MST file to customize the installation package:

msiexec /i " [Path]\SMART Education Software 2011.msi" [Properties]
[Parameter]
Where
o [Path] is the path to the SMART Education Software 2011.msi file and MST file.
o [MST file] is the name of the MST file.

o [Properties] is a set of properties you can include to customize the installation (see SMART
Classroom Suite Teacher installation package on page 59).

IMPORTANT

If you installed SMART Administrator Tools - Classlist Manager and created a
SMART School file, include the SCHOOLFILE and the ENABLE_ADMINISTERED _
CLASSLIST properties.

o [Parameter] is the installation parameter (see Parameters on page 81).

To install the Adobe Flash Player ActiveX control

Run the following command:

msiexec /i "[Path]J\install flash player 10 active x.msi" [Parameter]

Where
e [Path] is the path to the install_flash_player_10_active_x.msi file.

o [Parameter] is the installation parameter (see Parameters on page 81).

34



CHAPTER 3

Installing the software across a school or district

To install the Adobe Flash Player plug-in

Run the following command:

msiexec /i " [Path]\install_flash_player_lO_plugin.msi" [Parameter]

Where
e [Path] is the path to the install_flash_player_10_plugin.msi file.

e [Parameter] is the installation parameter (see Parameters on page 81).

Toinstall SMART Classroom Suite Student software, you must deploy the SMART Classroom
Suite Student.msi file.

To install SMART Classroom Suite Student software

Run the following command if you created an MST file to customize the installation package:

msiexec /i " [Path]J\SMART Classroom Suite Student.msi"™ TRANSFORMS="[MST
file]" [Parameter]
OR

Run the following command if you didn’t create an MST file to customize the installation package:

msiexec /1 " [Path]\SMART Classroom Suite Student.msi" [Properties]
[Parameter]
Where
e [Path] is the path to the SMART Classroom Suite Student.msi file and MST file.
o [MST file] is the name of the MST file.

o [Properties] is a set of properties you can include to customize the installation (see SMART
Classroom Suite Student installation package on page 72).

IMPORTANT

If you installed SMART Sync Class List Server include the
SYNC_NAMINGSERVERLOC property.

o [Parameter] is the installation parameter (see Parameters on page 81).
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Using third-party imaging or remote management software

The following procedure shows how to deploy SMART software using Group Policy-based
deployment software. For information on deploying SMART software using your organization’s
third-party imaging or remote management software, see the software’s documentation.

H NoOTES

o This procedure may vary depending on your version of Windows operating system and your
system preferences.

o Ensure your domain controller has Windows Installer 4.5.

To deploy an installation package

1. Copy the MSI file and the MST file to \\[Domain ControllerANETLOGON, where
[Domain Controller] is your domain controller.

2. Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.

The Active Directory Users and Computers window appears.
3. Right-click your domain, and then select Properties.
The Properties dialog box appears.
4. Click the Group Policy tab, and then click Edit.
The Group Policy Object Editor dialog box appears.
5. Browse to and open Computer Configuration\Software Settings.

6. Right-click Software Installation, select New > Package, and then browse to and select the
MSI file from step 1.

7. Inthe Deploy Software section, click Advanced, and then click OK.

8. Click the Modifications tab, click Add, and then browse to and select the MST file from
step 1.

9. Click OK to apply the MST file to the MSI file.
10. Close all open windows and dialog boxes.

The next time each computer on the domain starts, the computer automatically installs the
software in Silent mode with the customizations defined in the MST file.
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You can remove SMART software using the command line interface.
OR

You can remove SMART software using third-party imaging or remote management software.

Using the command line interface, you can remove SMART software in many ways, including
running commands from the Command Prompt window and including commands in batch script files.

To remove SMART Classroom Suite Teacher software

Run the following command to remove the software using the installation package:

msiexec /x " [Path]J\SMART Education Software 2011.msi" [Parameter]

OR

Run the following command to remove the software using the product code:

msiexec /x {A4E43135-BBC1-433A-B04A-A8F6FFOEGE23} [Parameter]

Where
e [Path] is the path to the SMART Education Software 2011.msi file.

e [Parameter] is the installation parameter (see Parameters on page 81).

To remove SMART Classroom Suite Student software

Run the following command to remove the software using the installation package:

msiexec /x " [Path]J\SMART Classroom Suite Student.msi" [Parameter]

OR
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Run the following command to remove the software using the product code:

msiexec /x {0ODE38CE9-7C96-4F0F-A10E-OCBA75F21229} [Parameter]

Where
e [Path] is the path to the SMART Classroom Suite Student.msi file.

e [Parameter] is the installation parameter (see Parameters on page 81).

To remove SMART Sync Class List Server and SMART Administrator Tools - Classlist
Manager

Run the following command to remove the software using the installation package:
msiexec /x " [Path]\SMART Administrator Tools 2011.msi" [Parameter]
Where

o [Path] is the path to the SMART Administrator Tools 2011.msi file.

e [Parameter] is the installation parameter (see Parameters on page 81).
OR
Run the following command to remove the software using the product code:

msiexec /x {7062B1A8-9483-49B0-R4E6-639459C1BB67} [Parameter]

Where [Parameter] is the installation parameter (see Parameters on page 81).

The following procedure shows how to remove SMART software using Windows operating systems’
Group Policy-based deployment software. For information on removing software using your
organization’s third-party imaging or remote management software, see the software’s
documentation.

H nNoTE

This procedure may vary depending on your version of Windows operating system and your system
preferences.
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To remove a deployed installation package

39

1.

Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.

The Active Directory Users and Computers window appears.
Right-click your domain, and then select Properties.

The Properties dialog box appears.

Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

Browse to and open Computer Configuration\Software Settings\
Software Installation.

Right-click the software you want to remove, and then select All Tasks > Remove.
Select Immediately uninstall the software from users and computers, and then click OK.

The next time each computer on the domain starts, the computer automatically removes the
software.
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SMART Install Manager enables you to customize SMART software installation packages (also
known as MSI files) by publishing MST files. You can then deploy the MSI and MST files to
computers using third-party imaging or remote management software.

Download and install SMART Install Manager from the SMART Support website.

To install SMART Install Manager from the website

1. Go to smarttech.com/administratordownloads.

2. Scroll to SMART Classroom Suite interactive leaming software, click Choose a version, and
then select SMART Classroom Suite software > 2011 for Windows.

3. Click Download SMART Install Manager, and then click Download.
4. Save the Install Manager.exe file to your computer.
5. Double-click the Install Manager.exe file.

The SMART Install Manager installation wizard appears.

6. Follow the on-screen instructions.
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After you install SMART Install Manager, shortcuts to the software appear on the desktop and in the
Start menu under All Programs > SMART Technologies > SMART Install Manager.

With SMART Install Manager, you can do the following:
e Open and customize an installation package.
e Save your changes to the installation package as an XML file.

o Publish your changes to the installation packages as an MST file.

Opening an installation package
To customize an installation package, drag its MSl file into the SMART Install Manager window.

Alternatively, you can search for installation packages on your computer by clicking o] .

H nNoTE

Allinstallation packages you've previously opened in SMART Install Manager appear in the
Unmodified Packages tab.
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After you open an installation package, a set of pages for that installation package appears in
SMART Install Manager. Customize the installation package using the controls on these pages.

& SMART Install Manager: Education Software Installer - Untitled

File Help

Welcome

Page links

Installation Options

Language Selection

SMART Product Update
SMART Notebook

Gallery Content

Team Content

My Content

Optional Settings

Customer Experience
SMART Response

Activation Options

Setup Tool

Optional Settings

SMART Sync Teacher

IE)

Technologies

Product Selection

Activate software during installation

Select the products you want to install

Caution: You haven't selected any products. Select at least one product to instal,
[] sMART Product Drivers

[] SMART Motebook software
Product key:
Enter the 22 digit product key for your product
&.0. NB-AB2DEFG3IK-AMAPQ-RE5UY
[] SMART Response software

If you're installing SMART Response CE (for use with SMART Natebook SE software) or SMART
Response VE software and you have a product key, enter the product key below.

Product key:
Enter the 22 digit product key for your product
£.0. SR-ABZDEFG3IK-AMAPQRSSUY
[[] SMART Naotebook Math Tools
An activated version of SMART Notebook software is required.
Product key:

Enter the 22 digit product key for vour product

JEks

B

N

Page content

/

Saving your changes

After you customize an installation package, save your changes as an XML file by selecting File >
Save As. When you next start SMART Install Manager, load the XML file by selecting File > Open,
or by opening the MSI file and then selecting File > Import.

Publishing your changes as an MST file
The final step in using SMART Install Manager to customize an installation package is to publish your
changes as an MST file. To do this, select File > Publish, and then use the dialog box to define a

location for and create the MST file.

B 1ip

Publish the MST file in the same location as the MSI file.
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To customize the SMART Classroom Suite Teacher installation package, open the SMART
Education Software 2011.msi file in SMART Install Manager (see Using SMART Install Manager
on page 42), and then set the controls on each page.

Control

Procedure

‘ Notes

General Options: Product Selection

SMART Product Drivers.

Activate software during Select to activate the software You must include the product key
installation automatically during installation properties for the software you
rather than manually after are installing for this property to
installation. work.
For mass activation information,
see Activating the software after
installation.
SMART Product Drivers Select to install

SMART Notebook software

Select to install SMART Notebook
software.

Product key Type your 22-character product You can type the product key
key for SMART Notebook with or without hyphens.
software. When you type a volume product

key, the software activates when
you deploy it to your network
computers.

SMART Response Select toinstall If you choose to install

software SMART Response software. SMART Response software, you

must also install and activate
SMART Notebook software.
When you select this check box,
SMART Install Manager
automatically selects the
SMART Notebook check box.
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Mixed Reality Tools

Tools.

Control Procedure Notes
Product key If you're installing You can type the product key

SMART Response software and | with or without hyphens.

students use When you type a volume product

SMART Notebook SE (Student key, the software activates when

Edition) software or you deploy it to your network

SMART Response VE Internet- computers.

enabled devices to answer

questions, type your 22-character

product key for SMART Response

software.

SMART Notebook Math Select to install SMART Notebook | If you choose to install

Tools Math Tools. SMART Notebook Math Tools,
you must also install and activate
SMART Notebook software.
If you install SMART Notebook
software but don't install
SMART Notebook Math Tools or
Mixed Reality Tools, you're
unable to deploy this software at
a later date using the Education
Software Installer installation
package.

Product key Type your 22-character product You can type the product key

key for SMART Notebook with or without hyphens.

Math Tools. When you type a volume product
key, the software activates when
you deploy it to your network
computers.

SMART Document Camera | Select to install Mixed Reality If you choose to install Mixed

Reality Tools, you must also
install and activate
SMART Notebook software.

If you install SMART Notebook
software but don't install
SMART Notebook Math Tools or
Mixed Reality Tools, you're
unable to deploy this software at
a later date using the Education
Software Installer installation
package.
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Control Procedure Notes

Product key Type your 22-character product You can type the product key
key for Mixed Reality Tools. with or without hyphens.

When you type a volume product
key, the software activates when
you deploy it to your network
computers.

SMART Sync Teacher Select to install SMART Sync

software Teacher software.

Product key Type your 22-character product You can type the product key
key for SMART Sync Teacher with or without hyphens.
software. When you type a volume product

key, the software activates when
you deploy it to your network
computers.

SMART Classroom Suite | Select toinstall SMART When you select this check box,

software Classroom Suite Teacher SMART Install Manager
software. automatically selects the

SMART Notebook,

SMART Product Drivers,
SMART Response and
SMART Sync Teacher check
boxes. (These programs are part
of SMART Classroom Suite
Teacher software.)

Product key Type your 22-character product You can type the product key
key for SMART Classroom Suite | with or without hyphens.
Teacher software. When you type a volume product

key, the software activates when
you deploy it to your network
computers.
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Control

Procedure

Notes

General Options: Installation Options

Installation directory

Type the path to your preferred
folder for the software.

If you specify afolder, include a
back slash (\) at the end of the
path.

If you don't specify a folder,
Windows Installer installs the
software in [Program files]\
SMART Technologies\
Education Software where
[Program files] is C:\Program
Files for 32-bit versions of
Windows operating systems or
C:\Program File (x86) for 64-bit
versions of Windows operating
systems.

Ensure the folder path is valid.
SMART Install Manager doesn’t
verify the folder path.

Install Start menu and
desktop shortcuts

Select to create shortcuts in the
Start menu and on the desktop.

General Options: Language Selection

Select the language packs
you want to install

Select the check boxes of the
language packs you want to
install.

Some SMART software doesn’t
support all listed languages.
SMART Sync Teacher software
language support is managed
separately.

General Options: SMART Product Update Options

Install SMART Product
Update in Full Mode

Select to install
SMART Product Update (SPU) in
Full mode.

In Full mode, users can view
currently installed versions of
SMART software and their
product keys, and download and
install updates.

Install SMART Product
Update in Dashboard Mode

Select to install SPU in Dashboard
mode.

In Dashboard mode, users can
view only currently installed
versions of SMART software and

between SPU checks.

their product keys.
Do not install SMART Select to not install SPU.
Product Update
Check for updates Type the number of days (1to 60) | This option is available only if you

install SPU in Full mode.

By default, SPU checks for
product updates every 30 days.
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Control

Procedure

Notes

Notify users about SMART
product updates

Select to notify users of available
SMART product updates through
the Windows notification area.

This option is available only if you
install SPU in Full mode.

SMART Notebook: Gallery Content

See Installing and maintaining Gallery content on page 83.

SMART Notebook: Team Content

Team Content path

Type the path to the

Team Content folder, whichis a
location on your school’s network
where users can store shared
content.

For information on creating a
Team Content folder, see
Creating or connecting to Team
Content folders on page 97.

SMART Notebook: My Content

My Content path

Type the path to the My Content
folder, which is alocation on the

user's computer where he or she
can store individual content.

You can include environment
variables in the path.

SMART Notebook: Optional Settings

Install print capture driver

Select to include the Print Capture
Driver in the installation.

The Print Capture Driveris a
printer driver that enables users
to export content from other
programs to SMART Notebook
software by using the

SMART Notebook Document
Writer.

Register
SMART Document Camera
drivers

Select to enable the registration of
SMART Document Camera
drivers.

Disable the registration of
SMART Document Camera
drivers if they conflict with
existing third-party drivers on the
compulter.

If you choose to install Mixed
Reality Tools,

SMART Install Manager selects
this check box automatically.
You're unable to clear it.
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Control

Procedure

Notes

Install Notebook Plugin IE
Helper Object

Select to enable a plug-in that
allows you to download .notebook
files from Internet Explorer®
Internet browser.

If you don’t enable the plug-in,
Internet Explorer Internet browser
changes .notebook files’
extensions to .zip when
downloading them. As a result,
users are unable to open the files
in SMART Notebook software.

If you have a security policy
restricting the installation of any
Internet Explorer ActiveX plug-ins
(32-bit operating systems), don’t
enable the plug-in or the
installation might not succeed.

SMART Notebook: Customer Experience

Prompt users to choose to
participate in the Customer
Experience Program

Select to allow the user to enable
or disable the Customer
Experience Program.

When the software first starts, it
will ask the user whether he or
she wants to participate in the
Customer Experience Program.

Enable the Customer
Experience Program on all
computers

Select to automatically enable the
Customer Experience Program for
the user.

Disable the Customer
Experience Program on all
computers

Select to automatically disable the
Customer Experience Program for
the user.

SMART Response: Activation Options

Registry file

If you're installing

SMART Response software in
standard, LE, PE, XE or mixed
modes, type the path to the
activation registry file.

Contact SMART Support for
details.

SMART Response: Setup Tool

SMART Response LE

Select to enable students to
answer questions with
SMART Response LE clickers.
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Control

Procedure

Notes

SMART Response PE

Select to enable students to
answer questions with
SMART Response PE clickers.

SMART Response XE

Select to enable students to
answer questions with
SMART Response XE clickers.

SMART Response/Senteo

Select to enable students to
answer questions with
SMART Response or Senteo™
clickers.

SMART Response VE

Select to enable students to
answer questions with

SMART Response VE Intemet-
enabled devices.

SMART Notebook SE

Select to enable students to
answer questions with

SMART Notebook SE software in
SMART Response CE mode.

3 Which country sponsored Columbus's voyage?

OA  Portugal
o

B
JC  Englan
D
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Control

Procedure

Notes

Multiple SMART Response
devices in the same class

Select to enable students to
answer questions with Senteo,
SMART Response,

SMART Response LE,

SMART Response PE or
SMART Response XE clickers or
SMART Notebook SE software.
Select the Include

SMART Response VE check box
to also enable students to answer
questions with SMART Response
VE Internet-enabled devices.

SMART Response: Optional Settings

Start Desktop Menu at log
in for all users?

Select to start SMART Response
software when the user logs on.

File port

Type the port number for the file
data channel.
OR

Type * to use a random port
number for the file data channel.

This control is applicable only if
students answer questions with
SMART Notebook SE software.

The default port is 23458.

Secure Base port

Type the port number for the
encrypted data channel.

OR
Type * to use a random port

number for the encrypted data
channel.

This control is applicable only if
students answer questions with
SMART Notebook SE software.

The default port is 23457.

Certificate file

Type the path to the certificate file
for SSL digital certificate
encryption.

OR

Click Browse and then browse to
and select the certificate file.

This control is applicable only if
students answer questions with
SMART Notebook SE software.

SMART Sync Teacher: Administrator Setup

Administer class lists using
a SMART School file

Select to administer class lists
using a SMART School file, and
then type the path to the

SMART School file in the File
location box or click Browse, and
then browse to and select the
SMART School file.

Before you can specify the path
toa SMART School file, you
must install SMART
Administrator Tools - Classlist
Manager, and then use it to
create the SMART School file.
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Control

Procedure

Notes

Connect students using
SMART Sync Classlist
Server

Select to connect students using
SMART Sync Class List Server,
and then type the host name or IP
address for SMART Sync Class
List Server in the Hostname or
IP address box.

SMART Product Drivers: O

ptional Settings

Enable Tablet PC Support | Select to use Tablet PC This property is applicable for the
functionality with the Windows Vista and Windows 7
SMART Board interactive display | operating systems. It has no
without having to connect a Tablet | effect on other operating
PC. systems.

Start SMART Board Tools | Select to start SMART Board

at logon Tools when the user logs on.

Start Simple Network
Management Protocol
(SNMP) Agent

Select to enable remote monitoring
and control of your SMART
products and projectors from a
central location using SMART
SNMP Agent.

Register unsigned drivers

Select to enable the registration of
unsigned third-party drivers.

If you enable the registration of
unsigned third-party drivers, the
installation process could ask
users if they trust the makers of
the drivers during installation.
This can cause issues if you
deploy the installation in Silent
mode. Therefore, it's best to
disable the registration of
third-party drivers if you deploy
the installation in Silent mode.
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To customize the SMART Classroom Suite Student installation package, open the SMART
Classroom Suite Student.msi file in SMART Install Manager (see Using SMART Install Manager
on page 42), and then set the controls on each page.

Control

| Procedure

‘ Notes

General Options: Installation Options

installation.

Installation Type the path to your preferred folder | If you don’t specify a folder, Windows

directory for the software. Installer installs SMART Classroom
Suite Student software in [Program
filesA\SMART Technologies where
[Program files] is C:\Program Files
for 32-bit versions of Windows
operating systems or C:\Program File
(x86) for 64-bit versions of Windows
operating systems.

Product key Type your 22-character product key for | You can type the product key with or

SMART Classroom Suite software. without hyphens.

When you type a volume product key,
the software activates when you
deploy it to your network computers.

Activate SMART | Select to activate SMART Classroom

Class Suite during | Suite software automatically during

installation installation rather than manually after

Install Desktop
shortcuts

Select to create shortcuts on the
desktop.

General Options: SMART Product Update (SPU) Options

between SPU checks.

Install SMART Select to install SPU.
Product Update
Check for updates | Type the number of days (1 to 60) By default, SPU checks for product

updates every 30 days.

Notify users about
SMART product
updates

Select to notify users of available
SMART product updates through the
Windows notification area.

SMART Sync Student: Interface

Visible to students

Select to show the SMART Sync
Student software user interface to the
student.
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Control Procedure Notes
Hidden from Select to hide the SMART Sync If you select this option, the student
students Student software user interface from | won’t be able to do the following:

the student.

« Connect to ateacher by
selecting his or her name from a
list

o Manually start SMART Sync
Student software

o Manually enteran ID after
starting SMART Sync Student
software

SMART Sync Student: Connection with Teacher

Allows the student
to select from a
list of available
teachers

Select to allow the student to select a
teacher from a list.

This option is disabled if you select
Hidden from students in the
Interface page.

In addition, if you select

Hidden from students but don’t
select one of the three options below
and provide a teacher ID, host name or
IP address, the student will not be able
to connect to a teacher.

Automatically
connects with this
Teacher ID

Select to connect SMART Sync
Student software to a specific teacher
through the teacher’s ID.

Type the ID in the box below the
option.

Automatically
connects with this
host name or IP
address

Select to connect SMART Sync
Student software to a specific teacher
through the host name or IP address.
Type the host name or IP address in
the box below the option.

If your network uses DHCP, refer to
the computer by host name rather than
by IP address.

Automatically
connects with
classes the
student belongs to

Select to connect SMART Sync
Student software to the classes the
student belongs to.

Uses this Class
List Server host
name or IP
address

Select to connect SMART Sync
Student software to a specific teacher

using SMART Sync Class List Server.

Type the host name or IP address of
the SMART Sync Class List Server
computer in the box below the check
box.

If your network uses DHCP, refer to
the computer by host name rather than
by IP address.
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Control

Procedure

Notes

SMART Sync Student: Options

Start

SMART Sync
Student
automatically...

Select to start SMART Sync Student
software when the student first logs
on.

This check box is disabled if you
select Hidden from students in the
Interface page.

Ask questions

Select to allow the student to ask
questions.

This check box isn’t visible if you
select Hidden from students in the
Interface page.

Chat Select to allow the student to chat with | This check box isn’t visible if you
other students. select Hidden from students in the
Interface page.
Submit files Select to allow the student to submit | This check box isn’t visible if you
files. select Hidden from students in the
Interface page.
Exit the Student | Select to allow the student to close This check box isn’t visible if you
program SMART Sync Student software. select Hidden from students in the

Interface page.

SMART Sync Student: Student ID

Student Select to allow the student to enter an | This option is disabled if you select

Controlled ID when SMART Sync Student Hidden from students in the
software starts. Interface page.

If you select this option, SMART Sync
software doesn’t apply Internet and
application blocking rules until after the
student enters an ID and joins the
class.

The following Select to enter a specific student ID. | This option is best if students use the
Type the ID in the box below the same computer every day or if you
option. want to give computers names.

Found in this Select to find the student ID in an

Active Directory
field...

Active Directory field of the student’s
login account.

Type the Active Directory field name in
the box to the right of the option.

Anonymous

Select to allow the student to use
SMART Sync Student software
without entering an ID.

Select this option if students change
computers or if user privacy is
required.
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Control

Procedure

Notes

SMART Sync Student: Shared Files Folder

My Documents
folder

Select to store files the teacher shares
with the student in the My Documents
folder (Windows XP or Windows 7
operating systems) or Documents
folder (Windows Vista operating
system).

Custom folder

Select to store files in another folder.

Type the path to the folder in the box
below the option.

SMART Notebook SE: Optional Settings

Install Notebook
Plugin IE Helper
Object

Select to enable a plugin that allows
you to download .notebook files from
Internet Explorer Internet browser.

If you don’t enable the plugin,

Internet Explorer Internet browser
changes .notebook files’ extensions to
.zip when downloading them. As a
result, users are unable to open the
files in SMART Notebook SE
software.

If you have a security policy restricting
the installation of any

Internet Explorer ActiveX plug-ins (32-
bit operating systems), don’t enable
the plugin or the installation may not
succeed.

SMART Notebook SE: Gallery Content

See Installing and maintaining Gallery content on page 83.

SMART Notebook SE: Team Content

Team Content
path

Type the path to the Team Content
folder, which is a location on your
school’s network where users can
store shared content.

For information on creating a

Team Content folder, see Creating or
connecting to Team Content folders
on page 97.

SMART Notebook SE: My Content

My Content path

Type the path to the My Content
folder, which is a location on the user's
computer where he or she can store
individual content.

You can include environment variables
in the path.

SMART Notebook SE: My Binder Directory

Application Data

Select to save the student’s Binder
files in the Application Data folder.

My Documents

Select this option to save the student’s
Binder files in the My Documents
folder.
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Control

Procedure

Notes

Other

Select this option to save the student’s
Binder files in another folder, and then
type the path to this folder in the box.

SMART Notebook SE: Customer Experience

Allow users to
participate in the

Select to allow the user to enable or
disable the Customer Experience

When the software first starts, it will
ask the user whether he or she wants

Customer Program. to participate in the Customer
Experience Experience Program.
Program

Enable the Select to automatically enable the

Customer Customer Experience Program for the

Experience user.

Program on all

computers
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SMART Classroom Suite Teacher installation package
The following are properties for the SMART Classroom Suite Teacher installation package:

for SMART Notebook software you
received from SMART.

Property ‘Allowed values ‘ Notes

General properties

ACTIVATE_ 1 (default): Register the product keys | You must include the product key

LICENSE and automatically activate the properties for the software you are
software. installing for this property to work.
[Empty string]: Register the product | For mass activation information, see
keys but don’'t automatically activate | Activating the software after
the software. installation.

INSTALL 1: Install SMART Notebook software.

NOTEBOOK

NB_PROD_KEY |[String]: The 22-character product key | This property automatically populates

the Product Key box in the activation
wizard if you choose not to include the
ACTIVATE_LICENSE property.

INSTALL_BOARD

1: Install SMART Product Drivers.

INSTALL_
RESPONSE

1: Install SMART Response software.

If you include the INSTALL_
RESPONSE property, Windows
Installer installs SMART Notebook
software even if you don’t include the

INSTALL_NOTEBOOK property.

59




APPENDIX A

Windows Installer properties and parameters

received from SMART if students use
SMART Notebook SE software or
SMART Response VE Intemet-
enabled devices to answer questions.

Property Allowed values Notes
RESP_PROD _ [String]: The 22-character product key | This property automatically populates
KEY for SMART Response software you | the Product Key box in the activation

wizard if you choose not to include the
ACTIVATE_LICENSE property.

ENABLE_MATH_

1: Install SMART Notebook

If you include the ENABLE_MATH__

from SMART.

TRIAL Math Tools. TRIAL property, Windows Installer
installs SMART Notebook software
even if you don'’t include the
INSTALL_NOTEBOOK property.

MATH_PROD _ [String]: The 22-character product key | This property automatically populates

KEY for SMART Notebook Math Tools you |the Product Key box in the activation

received from SMART. wizard if you choose not to include the
ACTIVATE_LICENSE property.

ENABLE_MR _ 1: Install Mixed Reality Tools. If you include the ENABLE_MR _

TRIAL TRIAL property, Windows Installer
installs SMART Notebook software
even if you don’t include the
INSTALL_NOTEBOOK property.

MIXED_PROD_ |[String]: The 22-character product key | This property automatically populates

KEY for Mixed Reality Tools you received |the Product Key box in the activation

wizard if you choose not to include the
ACTIVATE_LICENSE property.

INSTALL_SYNC

1: Install SMART Sync Teacher
software.

« SMART Notebook software

e SMART Product Drivers

o SMART Response software

o SMART Sync Teacher software

[Empty string]: Don’t install the
SMART Classroom Suite Teacher
software components.

SYNC _PROD_ [String]: The 22-character product key | This property automatically populates
KEY for SMART Sync Teacher software the Product Key box in the activation
you received from SMART. wizard if you choose not to include the
ACTIVATE_LICENSE property.
INSTALL 1: Install the SMART Classroom Suite
CLASSSUITE Teacher software components:
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Property

Allowed values

Notes

CLASS_PROD
KEY

[String]: The 22-character product key
for SMART Classroom Suite Teacher
software you received from SMART.

This property automatically populates
the Product Key box in the activation
wizard if you choose not to include the
ACTIVATE_LICENSE property.

INSTALLDIR

[String]: The path to your preferred
folder for the software.

If you specify a folder, include a back
slash (\) at the end of the path.

If you don’t specify a folder, Windows
Installer installs the software in
[Program files]\

SMART Technologies\

Education Software where [Program
files] is C:\Program Files for 32-bit
versions of Windows operating
systems or C:\Program File (x86) for
64-bit versions of Windows operating
systems.

DESKTOP_
ICONS

1 (default): Include shortcuts to the
software on the desktop.

[Empty string]: Don’t include
shortcuts to the software on the
desktop.

TRANSFORMS

[String]: A language MST file for the
installation (see Installation language
files and codes on page 101).

Ensure the specified MST file is in the
same folder as the MSI file.

This property defines the language of
the installer's user interface and the
installed software’s icons and
shortcuts. It doesn’t define the
installed software’s user interface
language. The installed software uses
the computer’s operating system
language if it's supported, or English
(U.S.)if not.

You can also use the TRANSFORMS
property to apply an MST file created
by SMART Install Manager (see page
41) or a third-party tool.
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Property ‘Allowed values Notes
SPU properties
INSTALL_SPU 1 (default): Install SPU in Full mode. | In Full mode, users can view currently
0: Don't install SPU. installed versions of SMART software
and their product keys, and download
and install updates.
In Dashboard mode, users can view
only currently installed versions of
SMART software and their product
keys.
SPU_TIME_ [Integer]: The time in days (1 to 60) By default, SPU checks for product
FRAME between SPU checks. updates every 30 days.
This property is applicable only if you
install SPU.
PRODUCT _ 1 (default): Notify the user when This property is applicable only if you
NOTIFICATION updates are available from SPU. install SPU.
0: Don’t notify the user when updates
are available from SPU.
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Property

Allowed values

Notes

SMART Notebook software properties

CONTENT_
TARGET _
PATH

CONTENT_
SOURCE_
PATH
NETWORK_
CONTENT

If you're installing Gallery content on
each user's computer from the
SMART website (option 1):

e Set CONTENT_TARGET_
PATH to the path of the folder
where you want to install the
Gallery content (if you don’t
want to use the default folder
%ALLUSERSPROFILE%\
Application Data\

SMART Technologies).

If you're installing Gallery content on
each user's computer from a folder on
your school’s network (option 2):

e Set CONTENT_SOURCE_
PATH to the path of the folder
on your school’s network that
contains the Gallery
Essentials and Lesson
Activity Toolkit folders.

e Set CONTENT_TARGET_
PATH to the path of the folder
where you want to install the
Gallery content (if you don’t
want to use the default folder
%ALLUSERSPROFILE%\
Application Data\

SMART Technologies).

If you're installing Gallery contentin a
central location (option 3):

e Set NETWORK_CONTENT to
1.

o Set CONTENT_TARGET_
PATH to the path of the the
folder on your school’s network
that contains the Gallery
Essentials and Lesson
Activity Toolkit folders.

For more information on the three
options, see Installing Gallery content
on page 84.

If you select option 3, Windows
Installer ignores the FULL_GALLERY
and * CONTENT properties.

FULL_GALLERY

1: Install the full Gallery Essentials
collection.

ADMIN_
CONTENT

1: Install the Administration and
Evaluation category.

Don’t include this property if you
included the FULL_GALLERY
category.
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Property

Allowed values

Notes

ARTS_CONTENT

1: Install the Arts category.

Don't include this property if you
included the FULL_GALLERY
category.

ENGLISH_ 1: Install the English and Language Don't include this property if you

CONTENT Arts category. included the FULL_GALLERY
category.

GEOGRAPHY _ 1: Install the Geography category. Don't include this property if you

CONTENT included the FULL_GALLERY
category.

HISTORY_ 1: Install the History category. Don't include this property if you

CONTENT included the FULL_GALLERY

category.

MATH_CONTENT

1: Install the Mathematics category.

Don't include this property if you
included the FULL_GALLERY
category.

My Content folder, which is a location
on the user's computer where he or
she can store individual content.

PEOPLE_ 1: Install the People and Culture Don't include this property if you

CONTENT category. included the FULL_GALLERY
category.

SCIENCE_ 1: Install the Science and Technology |Don’t include this property if you

CONTENT category. included the FULL_GALLERY
category.

SPECIAL_ 1: Install the Special Needs category. |Don’t include this property if you

CONTENT included the FULL_GALLERY
category.

SPORTS _ 1: Install the Sports and Recreation Don't include this property if you

CONTENT category. included the FULL_GALLERY
category.

LAT_CONTENT | 1: Install the Lesson Activity Toolkit

collection.

TEAM _ [String]: Specify the path to the For information on creating a

CONTENT _ Team Content folder, whichis a Team Content folder, see Creating or

PATH location on your school’s network connecting to Team Content folders

where users can store shared content. | on page 97.

You must specify a path to an existing
folder in this property.

MY_CONTENT [String]: Specify the path to the You can include environment variables

in the path.

This property is useful if you want to
store content in a shared network
folder so users can access their

My Content folder from any computer
on the network.

64




APPENDIX A

Windows Installer properties and parameters

Property Allowed values Notes
PRINT_ 1 (default): Install the Print Capture The Print Capture Driver is a printer
CAPTURE Driver. driver that enables users to export
[Empty string]: Don't install the Print | content from other programs to
Capture Driver. SMART Notebook software by using
the SMART Notebook Document
Writer.
INSTALL 1 (default): Enable the registration of | Disable the registration of
DOCCAM _ SMART Document Camera drivers. SMART Document Camera drivers if
DRIVERS 0: Disable the registration of they conflict with existing third-party
SMART Document Camera drivers. | drivers on the computer.
NBPLUGIN_ 1 (default): Enable a plug-in that If you don’t enable the plug-in,
INSTALLED allows you to download .notebook Internet Explorer Internet browser
files from Internet Explorer Internet changes .notebook files’ extensions to
browser. .zip when downloading them. As a
0: Disable the plug-in. result, users are unable to open the
files in SMART Notebook software.
If you have a security policy restricting
the installation of any
Internet Explorer ActiveX plug-ins (32-
bit operating systems), don’t enable
the plug-in or the installation might not
succeed.
CUSTOMER _ 0: Disable the Customer Experience
LOGGING Program.
1 (default): Allow the user to enable or
disable the Customer Experience
Program.
2: Enable the Customer Experience
Program.
SMART Response software properties
RESPONSE_ [String]: The path to the Contact SMART Support for details.
ACTIVATION SMART Response software registry This property is app|icab|e on|y if
file. students answer questions using
Senteo, SMART Response,
SMART Response LE,
SMART Response PE or
SMART Response XE clickers.
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2: Install the software in CE mode.
(Students answer questions using
SMART Notebook SE software.)

4: Install the software in LE mode.
(Students answer questions using
SMART Response LE clickers.)

8 (default): Install the software in PE
mode. (Students answer questions
using SMART Response PE
clickers.)

16: Install the software in XE mode.
(Students answer questions using
SMART Response XE clickers.)

32: Install the software in VE mode.
(Students answer questions using
SMART Response VE Internet-
enabled devices.)

64: Install the software in Mixed
mode. (Students answer questions
using Senteo, SMART Response,
SMART Response LE,

SMART Response PE or
SMART Response XE clickers or
SMART Notebook SE software.)
128: Install the software in Mixed
mode with additional support for
SMART Response VE Intemet-
enabled devices.

Property Allowed values Notes
RESPONSE_ 1: Install the software in standard You or the user can change the mode
MODE mode. (Students answer questions after installation using the
using Senteo or SMART Response SMART Response Setup Tool.
clickers.)

LOSU_RDM 1 (default): Add the

SMART Response icon to the
notification area when the user logs
on.

[Empty string]: Don’'t add the
SMART Response icon to the
notification area when the user logs
on.

FILE_PORT [String]: The port you want to use to
receive assessment information from
SMART Notebook SE software.

This property is applicable only if
you're installing SMART Response
software in CE mode.
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Property

Allowed values

Notes

SECURE_BASE_
PORT

[String]: The secure port you want to
use to receive assessment
information from

SMART Notebook SE software.

This property is applicable only if
you're installing SMART Response
software in CE mode.

CERTIFICATE_
FOLDER

[String]: The path to and file name of
the security certificate for Diffie-
Hellman encryption.

This property is applicable only if
you're installing SMART Response
software in CE mode.

SMART Sync Teacher software properties

connect students using SMART Sync
Class List Server.

ENABLE_ 1: Administer class lists using a If you want to administer class lists
ADMINISTERED_ | SMART School file. using a SMART School file, you must
CLASSLIST [N ull or empty String] (defau”): Don’t install SMART Administrator Tools -
administer class lists using a Classlist Manager, use it to create the
SMART School file. file, and then specify the path to the
file using the SCHOOLFILE property.
SCHOOLFILE [String]: The path to the
SMART School file.
ENABLE_ 1: Connect students using If you want to connect students using
CONNECT_ SMART Sync Class List Server. SMART Sync Class List Server, you
STU DENTS_ [Nu” or empty String] (defau”): Don’t must install SMART SynC Class List
USING_CLS Server, and then specify the host

name or IP address inthe SYNC _
NAMINGSERVERLOC property.

SYNC_NAMING
SERVERLOC

[String]: The host name or IP address
of SMART Sync Class List Server.
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Property

‘Allowed values

Notes

SMART Product Drivers properties

SNMP_SERVICE

allowing you to remotely monitor and
control your SMART products and
projectors from a central location.
[Empty string] (default): Disable
SMART SNMP Agent.

ENABLE_ 1 (default): Use Tablet PC This property is applicable for the
STPCS functionality with the SMART Board | Windows Vista and Windows 7
interactive whiteboard without operating systems. It has no effect on
connecting a Tablet PC. other operating systems.
[Empty string]: Don’t use Tablet PC If you specify [Null], users don’t have
functionality with the SMART Board | touch support at the Windows logon
interactive whiteboard without screen.
connecting a Tablet PC.
LOSU_ 1 (default): Start SMART Board Tools
BRDTOOLS when the user logs on.
[Null]: Don’'t start SMART Board
Tools when the user logs on.
START_ 1: Enable SMART SNMP Agent,

INSTALL_
UNSIGNED _
DRIVERS

1: Enable the registration of unsigned
third-party drivers.

0 (default): Disable the registration of
unsigned third-party drivers.

If you enable the registration of
unsigned third-party drivers, the
installation process could ask users if
they trust the makers of the drivers
during installation. This can cause
issues if you deploy the installation in
Silent mode. Therefore, it’s best to
disable the registration of third-party
drivers if you deploy the installation in
Silent mode.

Language pack properties

SQ 1: Install the Albanian language pack.

AR 1: Install the Arabic language pack.

EU 1: Install the Basque language pack.

CA 1: Install the Catalan language pack.

ZH_CN 1: Install the Chinese (Simplified)
language pack.

ZH TW 1: Install the Chinese (Traditional)
language pack.

CS 1: Install the Czech language pack.

HR 1: Install the Croatian language pack.

DA 1: Install the Danish language pack.
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Property Allowed values Notes

NL 1: Install the Dutch language pack.

EN_GB 1: Install the English (UK) language
pack.

ET 1: Install the Estonian language pack.

Fl 1: Install the Finnish language pack.

FR 1: Install the French language pack.

GA 1: Install the Gaelic (Ireland) language
pack.

GD 1: Install the Gaelic (Scotland)
language pack.

GL 1: Install the Galician language pack.

DE 1: Install the German language pack.

EL 1: Install the Greek language pack.

HE 1: Install the Hebrew language pack.

HI_IN 1: Install the Hindi language pack.

HU 1: Install the Hungarian language
pack.

IS 1: Install the Icelandic language pack.

IT 1: Install the Italian language pack.

JA 1: Install the Japanese language pack.

KK 1: Install the Kazakh language pack.

KO 1: Install the Korean language pack.

LV 1: Install the Latvian language pack.

LT 1: Install the Lithuanian language
pack.

MK 1: Install the Macedonian language
pack.

MS 1: Install the Malay language pack.

MI 1: Install the Maori language pack.

NB 1: Install the Norwegian language
pack.

PL 1: Install the Polish language pack.

PT_PT 1: Install the Portuguese (Portugal)
language pack.

PT BR 1: Install the Portuguese (Brazil)
language pack.

RO 1: Install the Romanian language
pack.
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Property Allowed values Notes

RU 1: Install the Russian language pack.

SR 1: Install the Serbian language pack.

SK 1: Install the Slovak language pack.

SL 1: Install the Slovenian language
pack.

ES 1: Install the Spanish (Spain) language
pack.

ES_MX 1: Install the Spanish (Mexico)
language pack.

SW 1: Install the Swahili language pack.

SV 1: Install the Swedish language pack.

TR 1: Install the Turkish language pack.

UK 1: Install the Ukrainian language pack.

VA 1: Install the Valencian language
pack.

CY 1: Install the Welsh language pack.
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Property

‘Allowed values

Notes

Internet access properties

ACC

[Integer]: Enable Internet access for
specified components.

0: No components

1: Gallery Setup

2: Language Setup

3: Gallery Setup and Language
Setup

4: SPU

5: Gallery Setup and SPU
6: Language Setup and SPU
7: All components except

Customer Experience Program

8: Customer Experience
Program

9: Gallery Setup and Customer
Experience Program

10: Language Setup and
Customer Experience Program

11: All components except SPU
12: SPU and Customer
Experience Program

13: All components except
Language Setup

14: All components except
Gallery Setup

15 (default): All components
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SMART Classroom Suite Student installation package

The following are properties for the SMART Classroom Suite Student installation package:

Property

‘Allowed values

| Notes

General properties

installation (see Installation
language files and codes on page
101).

INSTALLDIR [String]: The path to your preferred | If you don’t specify a folder,
folder for SMART Classroom Suite | Windows Installer installs SMART
Student software. Classroom Suite Student software
in [Program files\SMART
Technologies where [Program
files] is C:\Program Files for 32-
bit versions of Windows operating
systems or C:\Program File (x86)
for 64-bit versions of Windows
operating systems.
ISX [String]: The 22-character product This property automatically
SERIALNUM key you received from SMART. populates the Product Key box in
the activation wizard if you choose
not to include the ACTIVATE _
LICENSE property.
ACTIVATE_ 1 (default): Register the product key | You must include the
LICENSE and automatically activate the ISX_SERIALNUM property for this
software. property to work.
[Empty string]: Register the product | For mass activation information,
key but don’t automatically activate |see Activating the software after
the software. installation.
TRANSFORMS [String]: A language MST file for the | Ensure the specified MST file is in

the same folder as the MSI file.

This property defines the language
of the installer’s user interface and
the installed software’s icons and
shortcuts. It doesn’t define the
installed software’s user interface
language. The installed software
uses the computer's operating
system language if it's supported,
or English (U.S.)if not.

You can also use the
TRANSFORMS property to apply
an MST file created by

SMART Install Manager (see page
41) or a third-party tool.
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Property

Allowed values

Notes

LOCALE

[Integer]: A language code for
SMART Sync Student software
(see Installation language files and
codes on page 101).

If you don’t specify a language
code using LOCALE,

SMART Sync Student software
uses the computer's operating
system language if it's supported,
or English (U.S.)if not.

SPU properties

INSTALL_SPU

1 (default): Install SPU in Full mode.
0: Don'tinstall SPU.

In Full mode, users can view
currently installed versions of
SMART software and their product
keys, and download and install
updates.

In Dashboard mode, users can
view only currently installed
versions of SMART software and
their product keys.

SPU_TIME_
FRAME

[Integer]: The time in days (1 to 60)
between SPU checks.

By default, SPU checks for product
updates every 30 days.

This property is applicable only if
you install SPU.

PRODUCT _
NOTIFICATION

1 (default): Notify the user when
updates are available from SPU.
0: Don’t notify the user when

updates are available from SPU.

This property is applicable only if
you install SPU.
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Property

Allowed values

Notes

SMART Notebook SE software properties

CONTENT_
TARGET _
PATH
CONTENT_
SOURCE_
PATH
NETWORK_
CONTENT

If you're installing Gallery content on
each user's computer from the
SMART website (option 1):

o Set CONTENT_TARGET_
PATH to the path of the folder
where you want to install the
Gallery content (if you don’t
want to use the default folder
%ALLUSERSPROFILE%\
Application Data\

SMART Technologies).

If you're installing Gallery content on
each user's computer from a folder
on your school’s network (option 2):

e Set CONTENT_SOURCE_
PATH to the path of the folder
on your school’s network that
contains the Gallery
Essentials and Lesson
Activity Toolkit folders.

e Set CONTENT_TARGET _
PATH to the path of the folder
where you want to install the
Gallery content (if you don’t
want to use the default folder
%ALLUSERSPROFILE%\
Application Data\

SMART Technologies).

If you're installing Gallery content in
a central location (option 3):
o Set NETWORK_CONTENT
to 1.

e Set CONTENT_TARGET_
PATH to the path of the the
folder on your school’s
network that contains the
Gallery Essentials and
Lesson Activity Toolkit
folders.

For more information on the three
options, see Installing Gallery
content on page 84.

If you select option 3, Windows
Installer ignores the FULL_
GALLERY and* CONTENT
properties.

FULL_GALLERY

1: Install the full Gallery Essentials
collection.
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Property

Allowed values

Notes

ADMIN_CONTENT

1: Install the Administration and
Evaluation category.

Don't include this property if you
included the FULL_GALLERY
category.

ARTS_CONTENT

1: Install the Arts category.

Don't include this property if you
included the FULL_GALLERY
category.

ENGLISH_CONTENT

1: Install the English and Language
Arts category.

Don't include this property if you
included the FULL_GALLERY
category.

GEOGRAPHY _
CONTENT

1: Install the Geography category.

Don't include this property if you
included the FULL_GALLERY
category.

HISTORY_CONTENT

1: Install the History category.

Don't include this property if you
included the FULL_GALLERY
category.

MATH_CONTENT

1: Install the Mathematics category.

Don’t include this property if you
included the FULL_GALLERY
category.

PEOPLE_CONTENT

1: Install the People and Culture
category.

Don't include this property if you
included the FULL_GALLERY
category.

SCIENCE_CONTENT

1: Install the Science and
Technology category.

Don't include this property if you
included the FULL_GALLERY
category.

SPECIAL_CONTENT

1: Install the Special Needs
category.

Don't include this property if you
included the FULL_GALLERY
category.

SPORTS_CONTENT

1: Install the Sports and Recreation
category.

Don't include this property if you
included the FULL_GALLERY
category.

LAT_CONTENT

1: Install the Lesson Activity Toolkit
collection.

TEAM_CONTENT_
PATH

[String]: Specify the path to the
Team Content folder, which is a
location on your school’s network
where users can store shared
content.

For information on creating a

Team Content folder, see Creating
or connecting to Team Content
folders on page 97.

You must specify a path to an
existing folder in this property.
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you want to place Binder files (if you
set the BINDERSELECTEDOPT
property to Other).

Property Allowed values Notes
MY_CONTENT [String]: Specify the path to the You can include environment
My Content folder, whichis a variables in the path.
location on the user's computer This property is useful if you want
where he or she can store individual to store content in a shared network
content. folder so users can access their
My Content folder from any
computer on the network.
BINDER ApplicationData: Place Binder files
SELECTEDOPT in
%USERPROFILE%\Application
Data.
MyDocuments: Place Binder files in
%USERPROFILE%\My
Documents.
Other: Place Binder files in a folder
specified in the BINDERDIR
property.
BINDERDIR [String]: The path to a folder where

PRINT_CAPTURE

1 (default): Install the Print Capture
Driver.

[Empty string]: Don’t install the Print
Capture Driver.

The Print Capture Driver is a printer
driver that enables users to export
content from other programs to
SMART Notebook software by
using the SMART Notebook
Document Writer.

CUSTOMER _
LOGGING

0: Disable the Customer Experience
Program.

1 (default): Allow the user to enable
or disable the Customer Experience
Program.

2: Enable the Customer Experience
Program.

SMART Sync Student software properties

CREATE_
SHORTCUTS

1 (default): Include shortcuts to
SMART Sync Student software in
the Start menu and on the desktop.
[Empty string]: Don’t include
shortcuts to SMART Sync Student
software in the Start menu and on
the desktop.
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Property

Allowed values

Notes

SYNC_VISIBLE

1 (default): Show the SMART Sync
Student software user interface.

0: Hide the SMART Sync Student
software user interface.

SYNC_
CONNECTUSED

0: Allow the student to select a
teacher from a list.

1: Connect SMART Sync Student
software to a specific teacher using
SMART Sync Class List Server.

2: Connect SMART Sync Student
software to a specific teacher
through the teacher’s ID defined in
SYNC_CONTEACHID.

3: Connect SMART Sync Student
software to a specific teacher

through the host name or IP address
defined in SYNC_CONNECTIP.

If you set SYNC_VISIBLE to 0,
you must set this property to 1, 2 or
3.

SYNC_
CONTEACHID

[String]: A teacher ID to which
SMART Sync Student software will
connect automatically.

SYNC_
CONNECTIP

[String]: A teacher host name or IP
address to which SMART Sync
Student software will connect
automatically.

SYNC_
USENAMINGSERVER

1: Specify a SMART Sync Class
List Server to connect to in the
SYNC_NAMINGSERVERLOC
property.

0: Don’t specify a SMART Sync
Class List Server.

SYNC_NAMING
SERVERLOC

[String]: A SMART Sync Class List
Server host name or IP address to
which SMART Sync Student
software will connect automatically.

SYNC_
AUTOSTART

1 (default): Start SMART Sync
Student software when the student
first logs on.

0: Don't start SMART Sync Student
software when the student first logs
on.

This property is only applicable if
you set SYNC_VISIBLE to 1.
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ACTDIRSTUDID

Directory field that contains the
student’s ID.

Property Allowed values Notes
SYNC_ENABLE 1 (default): Allow the student to ask | This property is only applicable if
QUESTIONS questions. you set SYNC_VISIBLE to 1.
0: Don’t allow the student to ask
questions.
SYNC_ 1 (default): Allow the student to chat | This property is only applicable if
ENABLECHAT with other students. you set SYNC_VISIBLE to 1.
0: Don’t allow the student to chat
with other students.
SYNC_ 1 (default): Allow the student to This property is only applicable if
ENABLEFILE submit files. you set SYNC_VISIBLE to 1.
TRANSFER 0: Don’t allow the student to submit
files.
SYNC_ 1: Allow the student to close This property is only applicable if
DISPLAYEXIT SMART Sync Student software. you set SYNC_VISIBLE to 1.
0: Don’t allow the student to close
SMART Sync Student software.
SYNC _ 0: Use a student ID found in an If youset SYNC_VISIBLE to 1,
STUDIDMODE Active Directory field specified in this property’s default value is 2. (If
SYNC_ACTDIRSTUDID. this property’s value is 2,
1: Use a student ID specified in SMART Sync software doesn’t
SYNC STUDENTID. apply Internet and application
2- Allow the student to enteran ID | Plocking rules until after the student
when SMART Sync Student enters an ID and joins the class.)
software starts. If you set SYN C_V|S|BLE to 0,
3: Allow the student to use thﬁs property’s default vglue is1.1In
SMART Sync Student software this situation, you must include
without entering an ID. SYNC_STUDENTID.
Set this property to 3 if students
change computers or if user privacy
is required.
SYNC_ [String]: The name or ID of an Active | If you include this property, SYNC _

STUDIDMODE is setto 0
automatically.

SYNC_
STUDENTID

[String]: A student ID.

If you include this property, SYNC _
STUDIDMODE is set to 1
automatically.
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(Windows XP and Windows 7
operating systems) or Documents
folder (Windows Vista operating
system).

[String]: Store files the teacher
shares with the student in another
folder specified in this property.

Property Allowed values Notes
SYNC_ [Null or empty string] (default): Store
CUSTSHRD files the teacher shares with the

FOLDER student in the My Documents folder

INSTALL_DOCCAM_
DRIVERS

1 (default): Enable the registration of
SMART Document Camera drivers.
0: Disable the registration of

SMART Document Camera drivers.

Disable the registration of

SMART Document Camera drivers
if they conflict with existing third-
party drivers on the computer.

Internet access properties
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Property

Allowed values

Notes

ACC

[Integer]: Enable Internet access for

specified components.

0: No components
1: Gallery Setup

2: Language Setup
3: Gallery Setup and
Language Setup

4: SPU

5: Gallery Setup and SPU
6: Language Setup and SPU

7: All components except
Customer Experience
Program

8: Customer Experience
Program

9: Gallery Setup and
Customer Experience
Program

10: Language Setup and
Customer Experience
Program

11: All components except
SPU

12: SPU and Customer
Experience Program

13: All components except
Language Setup

14: All components except
Gallery Setup

15 (default): All components
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The following are the standard Windows Installer parameters for the msiexec command.

Parameter Use
/q Hide the installation wizard.
H nNoTE
This is Silent mode.
/gb Show a basic installation wizard.
/gb! Show a basic installation wizard without a Cancel button.
/gqb+ Show a basic installation wizard with a dialog box signaling the end of the
installation.
/gb+! Show a basic installation wizard without a Cancel button but with a dialog box
signaling the end of the installation.
lqr Show a reduced installation wizard.
Iqf Show the full installation wizard, including a dialog box signaling the end of the
installation or the Fatal Error, User Exit or Exit dialog box.
/gn Hide the installation wizard and the dialog box signaling the end of the
installation.
/gn+ Hide the installation wizard but show the dialog box signaling the end of the
installation.
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Gallery content includes the following:

o Gallery Essentials, which is a collection of educational photos and other images, audio files,
and Adobe Flash Player compatible files.

o Lesson Activity Toolkit, which contains objects teachers can use to create their own lesson
activities.

You can access Gallery content from the Gallery tab.

There are three options for installing Gallery content.

Option Description

1 Install Gallery content on each user's computer from the SMART website.

2 Install Gallery content on each user's computer from a folder on your school’s
network.

3 Install Gallery content in a central location, and then configure the software to refer to

that location.

B Tip

The third option is ideal for environments where hard disk space on computers is limited.

Installing Gallery content on each computer from the SMART website

Configuring Gallery content using the command line interface

If you're customizing the software using the command line interface, include the CONTENT _
TARGET_PATH property in the installation package customization. You can also include the FULL _
GALLERY and *_CONTENT properties to define the Gallery content you want to install. For more
information on these properties, see Windows Installer properties and parameters on page 59.

Configuring Gallery content using SMART Install Manager
If you're customizing the software using SMART Install Manager, complete the procedure in this

section to configure Gallery content.

To configure Gallery content using SMART Install Manager

1. Open the software installation package in SMART Install Manager.
2. Click Gallery Content.

The Gallery Content page appears.
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Click Install the Gallery on each computer.

In the Destination location box, type the path of the location on each computer where you want
toinstall the Gallery collections (if you don’t want to use the default folder
%ALLUSERSPROFILE%\Application Data\SSMART Technologies).

Select the check boxes of the Gallery collections you want to install.

Publish your changes as an MST file, and then deploy the MS| and MST files.

Installing Gallery content on each computer from a folder on your
school’s network

Downloading Gallery content
Download Gallery content from the CD or the Internet to a folder on your school’s network following
the procedures in this section, and then install the content on each computer from this folder.

NOTE

To download Gallery content from the CD, you must have Gallery Setup on your computer. Gallery
Setup is included with SMART Install Manager, SMART Notebook software and
SMART Notebook SE software.

To download Gallery content from the CD

1.

2
3.
4
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Insert the CD in your computer’'s CD drive.

If the CD browser appears, close it.

In Windows Explorer, browse to [CD drive\Content\Gallery Essentials.
Double-click SMARTEssentials.gallerycollection.

Gallery Setup starts.

In the Content tab, select the check boxes of the categories you want to include and clear the
check boxes of the categories you don’t want to include.

In the Languages tab, select the check boxes of the language packs you want to include and
clear the check boxes of the language packs you don’t want to include.

B T

To see the language pack names in English, clear the Show native names check box.

In the Installation folder for Gallery content box, type the path to the folder where you want to
store the Gallery collection.
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10.

Click OK.
Gallery Setup installs the selected Gallery collection.
Click Finish.

Repeat steps 3 to 9 for the Lesson Activity Toolkit (/CD drive\Content\Lesson Activity
Toolkit\Lesson Activity Toolkit.gallerycollection).

To download Gallery content from the Internet

1.
2.

o o &~ »

Open the CD software installation package in SMART Install Manager.

Click Gallery Content.

The Gallery Content page appears.

Click Install the Gallery on each computer.

Click Download, and then select the location to download the Gallery content to.
Click OK to start the download.

Click Close when the download is complete.

Configuring Gallery content using the command line interface

If you're customizing the software using the command line interface, include the CONTENT _
SOURCE_PATH and CONTENT_TARGET_PATH properties in the installation package
customization. You can also include the FULL_GALLERY and *_CONTENT properties to define the
Gallery content you want to install. For more information on these properties, see Windows Installer
properties and parameters on page 59.

Configuring Gallery content using SMART Install Manager
If you're customizing the software using SMART Install Manager, complete the procedure in this
section to configure Gallery content.

To configure Gallery content using SMART Install Manager

1.
2.
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Open the software installation package in SMART Install Manager.
Click Gallery Content.

The Gallery Content page appears.

Click Install the Gallery on each computer.

In the Source location box, type the path to the folder on your school’s network that contains
the Gallery content (if you downloaded Gallery collections to your school’s network).
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In the Destination location box, type the path of the location on each computer where you want
toinstall the Gallery collections (if you don’t want to use the default folder
%ALLUSERSPROFILE%\Application Data\SMART Technologies).

Clear the check boxes of the Gallery collections you don’t want to install.

Publish your changes as an MST file, and then deploy the MSI and MST files.

Installing Gallery content in a central location

Downloading Gallery content
To place and use Gallery content in a central location on your school’s network, you must first
download the content from the CD or the Internet to that location by performing one of the procedures

in this section.

NOTE

To download Gallery content from the CD, you must have Gallery Setup on your computer. Gallery
Setup is included with SMART Install Manager, SMART Notebook software and
SMART Notebook SE software.

To download Gallery content from the CD

1.

2
3.
4
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Insert the CD in your computer’'s CD drive.

If the CD browser appears, close it.

In Windows Explorer, browse to [CD drive\Content\Gallery Essentials.
Double-click SMARTEssentials.gallerycollection.

Gallery Setup starts.

In the Content tab, select the check boxes of the categories you want to include and clear the
check boxes of the categories you don’t want to include.

In the Languages tab, select the check boxes of the language packs you want to include and
clear the check boxes of the language packs you don’'t want to include.

B T

To see the language pack names in English, clear the Show native names check box.

In the Installation folder for Gallery content box, type the path to the folder where you want to
store the Gallery collection.

Click OK.

Gallery Setup installs the selected Gallery collection.
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9. Click Finish.

10. Repeat steps 3 to 9 for the Lesson Activity Toolkit (/CD drive\Content\Lesson Activity
Toolkit\Lesson Activity Toolkit.gallerycollection).

To download Gallery content from the Internet
1. Open the CD software installation package in SMART Install Manager.
2. Click Gallery Content.
The Gallery Content page appears.
3. Click Share Gallery content with all computers from a common network location.

4. If youwant to download the Gallery Essentials collection, click Install beside Essentials for
Educators, and then follow the on-screen instructions.

5. If you want to download the Lesson Activity Toolkit collection, click Install beside Lesson
Activity Toolkit, and then follow the on-screen instructions.

Configuring Gallery content using the command line interface
If you're customizing the software using the command line interface, include the NETWORK _
CONTENT and CONTENT_TARGET_PATH properties in the installation package customization.

For more information on these properties, see Windows Installer properties and parameters on page
59.

Configuring Gallery content using SMART Install Manager
If you're installing the software using SMART Install Manager, complete the procedure in this section
to configure Gallery content.

To configure Gallery content using SMART Install Manager
1. Open the software installation package in SMART Install Manager.
2. Click Gallery Content.
The Gallery Content page appears.
3. Click Share Gallery content with all computers from a common network location.

4. Inthe Gallery location box, type the path to the folder on your school’s network that contains
the Gallery content.

5. Publish your changes as an MST file, and then deploy the MSI and MST files.
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After installing the software, you can modify Gallery content using Gallery Setup. This program is
available under %PROGRAMFILES%\Common Files\SMART Technologies\SMART Product
Update and you can run it from a graphical user interface or the command line.

To run Gallery Setup from a graphical user interface

1.

89

In Windows Explorer, browse to %PROGRAMFILES%\Common
Files\SMART Technologies\SMART Product Update.

Double-click Gallery Setup.exe.

The Select a Gallery dialog box appears.

Select the Gallery collection you want to modify, and then click OK.
Gallery Setup starts.

In the Content tab, select the check boxes of the categories you want to include and clear the
check boxes of the categories you don’t want to include.

In the Languages tab, select the check boxes of the language packs you want to include and
clear the check boxes of the language packs you don’'t want to include.

B T

To see the language pack names in English, clear the Show native names check box.

In the Installation folder for Gallery content box, type the path to the folder where you want to
store the Gallery collection.

Click OK.
Gallery Setup updates the selected Gallery collection.

Click Finish.



APPENDIX B

Installing and maintaining Gallery content

To run Gallery Setup from the command line
1. Open a Command Prompt window.

2. Type the following command:

"[Path]\Gallery Setup.exe" [Command] [Flags] [Parameters]

Where:

o [Path] is the path to the Gallery Setup.exe file.

B NoTE

The default path is %PROGRAMFILES %\Common
Files\SMART Technologies\SMART Product Update.

o [Command] is acommand (see Commands on the next page).
o [Flags] is one or more optional flags for the command (see Flags on page 92).

o [Parameters] is one or more parameters for the command (see Parameters on page 92).

Kl NOTEs
o Forexample commands, see Examples on page 94.
o Gallery Setup doesn’t support Windows Installer options.
3. Press ENTER.

Gallery Setup updates the selected Gallery collection.
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Commands

The following table defines available commands for Gallery Setup.

Command

Purpose

Notes

--downloadall

Download the entire Gallery
collection to a source folder.

--downloadsome

Download specific categories of the
Gallery collection to a source folder.

Specify which categories you want
to download using the --c

content.

parameter.

--installall Install the entire Gallery collection | If you omit the --source parameter,
from the source folder to the Gallery Setup doesn’t use a default
destination folder. path unless you provide the

--allowdownload flag.

If you omit the --destination
parameter, Gallery Setup uses the
default path defined in the Gallery
collection’s configuration.

--installsome Install specific categories of the If you omit the --source parameter,
Gallery collection from the source | Gallery Setup doesn’t use a default
folder to the destination folder. path unless you provide the

--allowdownload flag.

If you omit the --destination
parameter, Gallery Setup uses the
default path defined in the Gallery
collection’s configuration.

Specify which categories you want
to download using the --¢
parameter.

--teamcontent Register additional Team Content at | You must enter an existing Gallery
the folder specified by the destination.

--destination parameter.

--mycontent Set the default My Content path to
the folder specified by the
--destination parameter.

--repair Attempt to detect and optionally Include the —-allowcleanup
remove corrupted galleries. parameter to delete corrupted

galleries.

--uninstall Remove the installed Gallery
collection.

--register Define the location of Gallery Use this command with the

--destination and
--configuration parameters, or
with the --guid parameter.
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Flags
The following table defines available flags for Gallery Setup.
Flag Purpose Notes
--remote Prevent Gallery Setup from This disables the Check for
registering itself with the SMART Updates feature and prevents users
software. from updating the content.
--verbose Output progress of operations to

standard output when working in
command line mode.

--overrideproxy

Set Gallery Setup to ignore default
(system-wide or previously set)
proxy settings where applicable,
and use a proxy specified by the
--proxy parameter (server:port
format), using a user name and
password provided by the
--username and --password
parameters.

You can set a user name and
password without - -
overrideproxy, and still use it for
authentication with the default

proxy.

--allowdownload

Download the Gallery collection
from the default URL specified in
the configuration.

Use this flag with the --installall or
--installsome parameters when
you omit the --source parameter.

--forcedest

Share Gallery content across users.

Parameters

The following table defines available parameters for Gallery Setup.

Setup installs the Gallery
content.

Parameter Value Purpose Notes
--source [Path] Define the path to a local or If you omit this parameter, the
network folder where the Gallery |installation program uses the
content is stored before default URL from the Gallery
installation. configuration, as specified by the
--guid or --configuration
parameters.
-- [Path] Define the path to alocal or If you omit this parameter,
destination network folder where Gallery Gallery Setup uses this default

path found in the computer’s
registry:
%ALLUSERPROFILES%\
Application Data\
SMART Technologies\
Gallery Essentials.
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Parameter Value Purpose Notes
- [Path] Define the full pathto a If you omit this parameter, you
configuration .gallerycollection file, including | must provide the --guid
the file name. parameter to specify a known
Gallery collection.
--proxy [Server:Port] | Specifies the proxy used by
Gallery Setup when you include
the --overrideproxy flag.
--guid [Identifier] | Specify a known Gallery A Gallery collection is known if
collection to work with. Gallery Setup has already
opened its .gallerycollection file.
In this situation, use this
parameter instead of the
--configuration parameter.
--C [Alias] Download or install the category |You can include several --c¢
of the Gallery collection identified | parameters in a single command.
by [Alias]. Valid [Alias] values for the
Use this parameter with the Gallery Essentials collection are:
--downloadsome and e admin
--installsome commands. . arts
« english
o geography
o history
o Mmath
o people
e Science
« special
e Sports
--ui N/A Specify the user interface level. |Use --register with the
Use this parameter to show a --downloadall or
progress indicator and error --downloadsome parameters
messages. If you don'tinclude | to display the full user interface.
this parameter, Gallery Setup Use --register with the
works silently without a user --installall or --installsome
interface. parameters to display a minimal
user interface.
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Examples

Downloading a Gallery collection
Use the following command to copy a Gallery collection from a specific source folder to a common
destination folder:

"[Path]\Gallery Setup.exe" --downloadall --destination " [Path]"

--configuration " [Path]"

Downloading certain categories of a Gallery collection
Use the following command to copy only certain categories of a Gallery collection from a specific
source folder to a common destination folder:

"[Path]\Gallery Setup.exe" --downloadsome --destination " [Path]"
--configuration " [Path]" --c "[Alias 1]" --c "[Alias 2]"

Installing a Gallery collection
Use the following command to install a Gallery collection from the default source (as defined in the
.gallerycollection file) to a specific destination folder:

"[Path]\Gallery Setup.exe" --installall --allowdownload --destination
"[Path]" --configuration " [Path]"

Installing certain categories of a Gallery collection
Use the following command to install certain categories of a Gallery collection from the default source
(as defined in the .gallerycollection file) to a specific destination folder:

"[Path]\Gallery Setup.exe" --installsome --remote --source " [Path]"
--allowdownload --destination " [Path]" --configuration " [Path]"
--c "[Alias 1]" --c "[Alias 2]"

Registering installed Gallery collections
If you installed Gallery collections to a network location, use the following command to register the
Gallery content with the SMART software on each user’s computer:

"[Path]\Gallery Setup.exe" --register --remote --forcedest

--destination " [Path]" --configuration " [Path]"

Removing a Gallery collection
Use the following command to remove the Gallery Essentials collection:

"[Path]\Gallery Setup.exe" --uninstall --guid gallery.smarttech.com
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B 1p

To automate the removal of a Gallery collection, you can use the command in a batch file as a
startup script.

After installing the software, you can do the following:
¢ Change the location of the My Content folder.
o Create or connect to a Team Content folder.

e Connect to an RSS feed.

Starting the software in Administration mode
Before you can maintain content folders, you must start the software in Administration mode.

To start SMART Notebook software in Administration mode
1. Open a Command Prompt window.

2. Type the following command:

" [Path]\Notebook.exe" /admin
Where [Path] is the path to the SMART Notebook software program folder.
H NoTE
The default path is %PROGRAMFILES%\SMART Technologies\SMART Notebook.

3. Press ENTER.

SMART Notebook software starts in Administration mode.
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To start SMART Notebook SE software in Administration mode

1.
2.

Open a Command Prompt window.

Type the following command:

" [Path]\SMARTNotebookSE.exe" /admin

Where [Path] is the path to the SMART Notebook SE software program folder.

K NoTE
The default path is %PROGRAMFILES%\SMART Technologies\SMART Notebook SE.
Press ENTER.

SMART Notebook SE software starts in Administration mode.

Changing the location of the My Content folder

The My Content folder is a location where teachers and students can store content for their individual

use.

You can specify the location of the My Content folder during installation. If you don’t specify a
location, the default location is % APPDATA%\SMART Technologies\Gallery\My Content.

To change the location of the My Content folder after installation

1.
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Start the software in Administration mode (see Starting the software in Administration mode on
the previous page).

Click the Gallery tab.

Click the Click here for more Gallery options icon #, and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.

Click Browse.

The Browse For Folder dialog box appears.

Browse to and select the new My Content folder, and then click OK.
Click Close.

Close the software.
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Creating or connecting to Team Content folders
All users can create new content and save it in their My Content folders. To allow users to share
content, you must create or connect to a Team Content folder.

TIP

If you create a Team Content folder on a computer’s hard disk, the folder is available only to users
of that computer. However, if you create a Team Content folder on a server, the folder is available
to all users on the school’s network with read and write access to the folder.

To create a new Team Content folder

1.

Start the software in Administration mode (see Starting the software in Administration mode on
page 95).

Click the Gallery tab.

Click the Click here for more Gallery options icon &, and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.
Click Create New.
The Browse For Folder dialog box appears.

Browse to and select the folder you want to designate as a Team Content folder, and then
click OK.

H nNoTE

The software adds an imsmanifest.xml file to the Team Content folder after you click OK.
This file identifies the folder as a Team Content folder.

Click Close.

Close the software.

To connect to an existing Team Content folder

1.

2.
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Start the software in Administration mode (see Starting the software in Administration mode on
page 95).

Click the Gallery tab.
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Click the Click here for more Gallery options icon &, and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.

Click Add Existing.

The Browse For Folder dialog box appears.

Browse to and select the Team Content folder, and then click OK.
Click Close.

Close the software.

To disconnect a Team Content folder

1.

Start the software in Administration mode (see Starting the software in Administration mode on
page 95).

Click the Gallery tab.

Click the Click here for more Gallery options icon &, and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.

Select the folder in the Team Content list, and then click Remove.

IMPORTANT

If you installed the Gallery Essentials and Lesson Activity Toolkit collections, folders for
those collections appear in the Team Content list. Do not remove these folders from the list,
or users will not be able to access these collections.

Click Close.

Close the software.

Connecting to an RSS feed
You can connect to a public or private RSS feed to send information to your school’s
SMART Notebook software and SMART Notebook SE software users through the Gallery tab.

RSS is a format for delivering regularly changing web content. Many news-related websites, blogs
and other publishers broadcast their content as RSS feeds.
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To connect to an RSS feed

99

1.

Start the software in Administration mode (see Starting the software in Administration mode on
page 95).

Click the Gallery tab.

Click the Click here for more Gallery options icon ", and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.
Type the URL of the RSS feed in the Online Resources box.
Click Close.

Close the software.
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IMPORTANT

SMART Response software and SMART Sync Teacher software do not support the Basque
(1069.mst), Catalan (1027.mst), Chinese (Traditional) (1028.mst), Croatian (1050.mst), French
(Canada) (3084.mst), Hebrew (1037.mst), Japanese (1041.mst), Romanian (1048.mst), Serbian
(3098.mst), Slovak (1051.mst) and Slovenian (1060.mst) installation language files. If you want to
deploy the software in any of these languages:

o First deploy all software except SMART Response software and SMART Sync software
with the installation language file.

e Then deploy SMART Response software and SMART Sync software without the installation

language file.

Language Code File

English (U.S.) 1033 1033.mst
English (UK) 2057 2057.mst
Arabic 1025 1025.mst
Basque 1069 1069.mst
Catalan 1027 1027.mst
Chinese (Traditional) 1028 1028.mst
Chinese (Simplified) 2052 2052.mst
Croatian 1050 1050.mst
Czech 1029 1029.mst
Danish 1030 1030.mst
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Language Code File
Dutch 1043 1043.mst
Finnish 1035 1035.mst
French (France) 1036 1036.mst
French (Canada) 3084 3084.mst
German 1031 1031.mst
Greek 1032 1032.mst
Hebrew 1037 1037.mst
Hungarian 1038 1038.mst
Icelandic 1039 1039.mst
Italian 1040 1040.mst
Japanese 1041 1041.mst
Korean 1042 1042.mst
Norwegian 1044 1044.mst
Polish 1045 1045.mst
Portuguese (Portugal) 2070 2070.mst
Portuguese (Brazil) 1046 1046.mst
Romanian 1048 1048.mst
Russian 1049 1049.mst
Serbian 3098 3098.mst
Slovak 1051 1051.mst
Slovenian 1060 1060.mst
Spanish (Spain) 1034 1034.mst
Spanish (Mexico) 2058 2058.mst
Swedish 1053 1053.mst
Turkish 1055 1055.mst
File Code

myscript hwr (arabic).msi

{978A47F7-B01C-4E6B-8ED7-9C48DASEDS5D9}

myscript hwr (chinese).msi

{1CO8E9A9-AC34-41C1-82AE-28D052DBC500}

myscript hwr (danish).msi

{5CAADAAB-39A6-44D4-A189-19A5DDB704AF}

myscript hwr (dutch).msi

{FFE8B367-7349-406F-A583-F2795A0A0548}

myscript hwr (finnish).msi

{7762637E-C185-4252-8FE9-72BC095AB47C}

myscript hwr (french).msi

{9A960F35-C1DA-4FC0-B802-EAFF4179FDBO}

myscript hwr (german).msi

{415CD877-0970-4CB6-B178-1E72F7DCG0E7}
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File

Code

myscript hwr (greek).msi

{DBBEDES5D-3342-4C13-ABA1-E35DA1147EDS5}

myscript hwr (hungarian).msi

{FB4F5116-0220-4296-B888-CBAFEGAGBIC0}

myscript hwr (italian).msi

{OE5F9A13-4C27-4CE4-9E29-69223EE08FCF}

myscript hwr (japanese).msi

{B693FD69-0E52-4BD6-B2BA-59EC 10BB4BEF}

myscript hwr (korean).msi

{6CBF713D-6EC6-4BDF-9B40-6338ACOD1C 1A}

myscript hwr (norwegian).msi

{12A35C25-B07E-4481-B1A0-B36892C07491}

myscript hwr (polish).msi

{909E3219-72DE-40A3-9162-E653CBEBABF2}

myscript hwr (portuguese).msi

{727822B6-9BF7-41C0-AB57-8EE6E21814D9}

myscript hwr (russian).msi

{1F2282B4-7A07-4AD1-BFCF-C58F37E3EC2C}

myscript hwr (spanish).msi

{EDACGEOD-F93B-4B80-9377-F57D3BB5E6B 1}

myscript hwr (swedish).msi

{EB61ED3F-8C2F-4D3D-81BE-CA16DA87D515}

myscript hwr (turkish).msi

{319B07E6-4D8A-4A7F-BC38-BA39C4BADF4F}

File

Code

albanian_language_pack.msi

{62D3EB7B-8FB0-40B5-BD96-36733CE94C48}

arabic_language_pack.msi

{9091E771-6E47-4C01-B7BF-45BCG66ASABF9}

basque_language_pack.msi

{28F55FD9-DBDF-4180-BE83-E01614E092C9}

catalan_language_pack.msi

{48767968-5D64-44CB-83AD-6E57270F9E89}

pack.msi

chinese_(simplified)_language_

{C42566AD-8B6D-42DA-AB32-ABOFF4DA4835}

pack.msi

chinese_(traditional)_language_

{10A9A34A-8741-4251-AF92-6109498DDE11}

croatian_language_pack.msi

{D83EFF2B-275E-4B49-9391-76C85606F3C9}

czech_language_pack.msi

{65F93E53-1BF8-42CC-B34E-ADE8SF38A5DDD}

danish_language_pack.msi

{35F9BB11-C3B1-4E54-BCF6-A816219E8816}

dutch_language_pack.msi

{2F24F27E-3137-4A0E-8D1D-B3A203FBEB21}

pack.msi

english_(united_kingdom)_language_

{660B0281-20C5-4FC9-A249-40C 860262435}

estonian_language_pack.msi

{6E905FF9-781D-479A-A940-DA2AFDC6CF85}

finnish_language_pack.msi

{00FB911F-2E53-410F-BB04-040582241902}

french_language_pack.msi

{42EA3C50-D781-4408-A6BC-650E4EAA42B6}

gaelic_(ireland)_language_pack.msi

{E4AF8A18-E6D9-4F91-95A8-11E90D 972953}

gaelic_(scotland)_language_pack.msi

{AFC30958-4391-47CA-A4F9-7344B41717C3}

galician_language_pack.msi

{D8060D4D-19BA-45C5-874C-54F566DD4D27}
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File

Code

german_language_pack.msi

{FBD1D659-DFDF-4EFC-9EGE-187CF498380C}

greek_language_pack.msi

{8603B01E-C40B-470D-BFBA-F8CE4E7ECDBE}

hebrew_language_pack.msi

{11EC8FEF-D319-437F-ACF3-6348DD6CB4DB}

hindi_language_pack.msi

{9C6ABB27-F1BF-41DC-9CF6-757017C8FDFO0}

hungarian_language_pack.msi

{358DDBCC-B4CA-4B65-AB3D-7BDC34EADGOE}

icelandic_language_pack.msi

{14A6BC4A-677C-4111-9C63-3D642876C1ED}

italian_language_pack.msi

{337225D9-28B9-41BC-8157-57FF543D82E8}

japanese_language_pack.msi

{AB4FDB88-2330-4703-A529-BF8ADS553755C}

kazakh_language_pack.msi

{D5276407-8FBF-454F-8C18-BBB69D0C04B5}

korean_language_pack.msi

{98AB930B-8A8A-4639-95B0-8EE77BCC982F}

latvian_language_pack.msi

{344CAA11-F660-4561-817F-D673A2C45FB3}

lithuanian_language_pack.msi

{FF52AD70-9114-4AF1-8796-3F 7349230530}

macedonian_language_pack.msi

{50873596-D295-48C 1-9F4E-18674304716B}

malaysian_language_pack.msi

{9DE53468-3E21-4A57-B27C-AFATDAGOC5DD}

maori_language_pack.msi

{196D 58D 0-960E-4B46-860A-6D732F2BC473}

norwegian_language_pack.msi

{6BE163A5-1987-4789-96C4-9F5B481A0B09}

polish_language_pack.msi

{B84DD15C-A4CB-4769-8828-CAA31EA7TFAG}

portuguese_(portugal)_language_
pack.msi

{48B115BA-5E2B-4DB2-B1E2-9CO0A1DBF8405}

portuguese_(brazil)_language_pack.msi

{F1FF65A8-ECOC-43A4-8E4E-154EEBF4C081}

romanian_language_pack.msi

{ABCCO03AD-C6F7-417B-A756-918E5E325872}

russian_language_pack.msi

{441D1F4B-0DAD-4600-B17B-7F8880E4F9B4}

serbian_language_pack.msi

{B05B1B54-36C9-4F6A-97C9-10A1028BB1BB}

slovak_language_pack.msi

{20451FF6-BEF6-4D4C-B6FA-CE5F191DCF20}

slovenian_language_pack.msi

{1236683E-AF08-444B-9C5D-26C04A8BEOF 7}

spanish_language_pack.msi

{OEEE7AD9-6FB8-4837-8C87-E187D817D5AB}

spanish_(international_latin_american)_
language_pack.msi

{ACAEFF6B-076D-4307-AF29-EA2D23575773}

swahili_language_pack.msi

{1CE6DA19-D83D-4F7D-8038-B60648C8F1F5}

swedish_language_pack.msi

{6F22C4C4-D6F94E73-AFCA-93570FC12DCC}

turkish_language_pack.msi

{C3F1AFAG-DCFA-4DA3-AA28-F4770D4BA4FAS8}

ukrainian_language_pack.msi

{9D2460BE-585F-4155-A472-D5C8DA823B30}

valencian_language_pack.msi

{01016807-17B8-4257-9D6D-0EBADAB7B75E}

welsh_language_pack.msi

{679AECO0B-A357-4399-8820-11BA790A 1D 89}
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